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Abstract 

The work detailed in this thesis investigates the behaviour of the hydrodynamic interaction 

effects acting on an unappended AUV manoeuvring in proximity to a larger moving 

underwater vehicle such as a submarine. The investigation examined the steady-state and 

transient interaction effects on the hydrodynamic coefficients of the AUV as a function of the 

relative: speed, longitudinal position, lateral position, and size between the two submerged 

vehicles. The work involved extensive development of Computational Fluid Dynamics 

(CFD) models to simulate the manoeuvres in order to map the interaction behaviour. 

Experimental Fluid Dynamics (EFD) involving captive-model tests of the two vehicles were 

carried out to validate and supplement the CFD data. 

The results show that the hydrodynamic interaction acts to attract and repel the AUV at the 

stern and bow regions around the submarine, respectively. The magnitude of these attraction 

and repulsion interaction effects varied significantly due to small changes in the relative 

longitudinal position, suggesting the need of an accurate and fast responsive control system 

for the AUV to adequately maintain its trajectory around the submarine. These adverse 

interaction effects were found to be minimal around amidships of the moving submarine, 

suggesting a safe path for the AUV to approach or depart the submarine laterally within that 

region. In addition, the interaction effects on the hydrodynamic coefficients of the AUV were 

shown to reduce as the relative speed of the latter increased.  

Due to the need to simulate large relative motions between the two vehicles, this thesis also 

investigate and identifies the merits of two dynamic mesh techniques within ANSYS CFX 

(i.e. Immersed Solids, and AMP Re-Meshing) to simulate multiple bodies in relative motion. 

Although the numerical models behind the techniques have undergone substantial 

development in recent years, as they are beta-features in ANSYS CFX there are currently no 

existing studies demonstrating their capabilities in modelling multiple bodies in relative 

motion. The developed CFD simulation models are suitable for future work involving 

appended AUVs and the coupling with a control system for manoeuvring simulations of 

multiple underwater vehicles.  
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1.1 Introduction 

 

An Autonomous Underwater Vehicle (AUV) is an underwater robot containing its own 

power and control systems to accomplish a pre-defined task with little operator intervention. 

In recent decades, the research and development of AUVs have grown significantly due to 

the recognition by AUV operators, such as the offshore oil and gas industry and the defence 

sector, for the ability of AUVs to operate independently of a human pilot in hazardous 

environments for long periods of time. This development has been aided by the significant 

improvement of relevant technologies such as power storage, navigation systems, control 

systems, and computational hardware which have increased the capabilities, applications, and 

efficiencies of AUVs. However, in the design of the autonomous capabilities of AUVs, there 

is still a substantial amount of work to be done in terms of its hydrodynamic stability and 

manoeuvrability. In particular, there is very little information on the hydrodynamic 

interaction between submerged vehicles within the public domain, let alone the transient 

interaction effects acting on an AUV manoeuvring in relative motion to a larger underwater 

vehicle. These interaction effects can substantially hinder the operation of multiple 

underwater vehicles operating in close proximity, such as the deployment and recovery of an 

unmanned underwater vehicle from a submarine (Hardy & Barlow 2008; Watt et al. 2011). 

 

In 2006, a joint AUV development programme was initiated between the Defence, Science 

and Technology Organisation (DSTO) and the National Centre for Maritime Engineering and 

Hydrodynamics (NCMEH) at the Australian Maritime College (AMC). The aims of the 

programme were to explore  both  the  design  and  operational  challenges associated  with  

the  use  of  Unmanned Underwater Vehicles (UUVs) to meet the needs of the Royal 

Australian Navy (RAN); in particular, the RAN’s vision to extend beyond single-vehicle 

undersea operations to multiple vehicles operating within a cooperative framework. In 

support of this approach, the work presented in this thesis was initiated and partially funded 

by DSTO to: 

 

 provide insight into the effects of hydrodynamic interaction on an AUV manoeuvring 

near a larger moving underwater vehicle such as a submarine; and  

 develop the means to investigate such interaction through an integration of 

Computational Fluid Dynamics (CFD) modelling and experimental work.  
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1.1.2 Problem Definition 

 

Hydrodynamic interaction is classified as the external forces acting on a vessel that occur 

only when the vessel is close to another vessel or an obstruction such as an iceberg, the 

seabed, underwater structures, etc. (Mackay 2003; Acosta et al. 2008; Kimball & Rock 2011). 

When an AUV is manoeuvring in proximity to a moving submarine, interaction with the 

latter’s wake and pressure fields can impose rapid changes in the acceleration of the AUV 

(Fedor 2009; see Figure 1.1). This can substantially hinder the approach and recovery of the 

AUV, and increase the risk of collision as the two vehicles draw closer. In extreme cases 

collision can result in damage or destruction of the AUV and possible damage to the 

submarine’s appendages or sensors. Given that the AUV is relatively small and self-piloted 

by an on-board computer, the vehicle is more susceptible to the interaction effects. Therefore, 

it is important to have a good understanding of the AUV’s behaviour under the effects of the 

interaction to enable the designers and operators to deal with rapid changes in the pressure 

and velocity fields. This includes developing control systems that are sufficiently robust and 

adaptive, improving the hydrodynamic design of the vehicle and developing operating 

procedures in order to improve the safety of the vehicle when manoeuvring in close 

proximity to a submarine. 

 

 

Figure 1.1: An AUV moving in the wake of a submarine. 

 

In general, the hydrodynamic and manoeuvring characteristics of AUVs can be evaluated and 

quantified through experimental and empirical methods such as captive model testing and 

system identification of the actual vehicle respectively. However, these methods require 

considerable cost and time, and are restricted by the requisite of a physical model of the 

vehicle and suitable test facilities. In the case of multi-vehicle investigations, the cost can 
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significantly increase for each additional vehicle involved due to the measurement equipment 

and infrastructure required (Park et al. 2008).  

 

For the prediction of the vehicle’s hydrodynamic characteristics in unrestricted water; the 

facilities need to be sufficiently large to avoid excessive blockage effects (Quick et al. 2012), 

and sufficiently deep to avoid interaction effects with the free surface and the bottom of the 

tank (Mackay 2003). The size of the facility also imposes a speed restriction on the vehicle 

(Bertram 2000). For system identification of the vehicle’s hydrodynamic characteristics from 

sea trials, the accuracy of the method is limited to the flow quality of the environment and the 

capability of the algorithms to estimate the hydrodynamic coefficients from the measured 

data (Pereira & Duncan 2000; Yoon & Rhee 2003; Xie et al. 2014). While many 

experimental studies have investigated hydrodynamic interactions between surface ships 

(Taylor 1909; Newman 1960; Remrey 1974; Kyulevcheliev & Varyani 2004; Kribel 2005), 

the hydrodynamic interaction effects between underwater vehicles in relative motion are 

harder to model and measure experimentally, due to their greater free-body motion in six 

degrees of freedom (6-DOF) and as such have not been as extensively investigated.  

 

With the ongoing development of high performance computing facilities and numerical codes 

to predict fluid flow and pressure fields, computer based simulations using CFD are 

becoming more capable of replicating conditions that are difficult or costly to achieve 

through experimental processes. Properly developed Reynolds Averaged Navier-Stokes 

(RANS)-based CFD simulations have shown to be capable of predicting the hydrodynamic 

coefficients of underwater vehicles with a high degree of accuracy, and are comparable to 

experimental methods (Watt et al. 2006; Toxopeus 2008; Phillips 2010; Toxopeus 2012; Kim 

et al. 2013; Zhang et al. 2013). They offer a greatly reduced computational cost in 

comparison to Large Eddy Simulation (LES) and Direct Numerical Simulation (DNS) due to 

the lesser mesh requirement to capture the boundary layers on the vehicles (Alin et al. 2010). 

In addition, CFD has been demonstrated to capture interactions between surface ships with 

good agreement to experimental measurements (Chen et al. 2003; Huang and Chen 2003).  

This makes RANS-based simulations attractive to investigate the hydrodynamic interaction 

between multiple underwater vehicles by simulating conditions that are difficult or costly to 

achieve through experimental means, e.g. full-scale tests, free running vehicles, and flow 

visualisation. However, one of the major challenges faced when using CFD as an analysis 

tool is that the computational results can vary greatly depending on the experience of the 
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analyst, the settings utilised such as the boundary condition and the turbulence models, and 

the quality of the mesh model; thus necessitating verification through processes such as grid 

independence studies and validation through experimental or full-scale data.  

 

Another numerical approach is potential flow modelling, which is widely accepted to be a lot 

faster and computationally cheaper to solve fluid flow problems compared to CFD. However, 

studies by many researchers (e.g. Kadri and Weihs, 2014; Jayrathne et al., 2014) show that 

potential flow modelling is unable to produce accurate force and moment predictions of the 

interaction effects between surface vehicles when compared to experimental measurements. 

This is due to the limited capability of potential flow solvers to model recirculating flow 

which is important to capture the wake behind a vehicle. Thus, CFD is used in this thesis. 

 

1.1.3 Objectives 

 

The aims of the project are to investigate the hydrodynamic behaviour of an AUV under the 

influence of the interaction with a larger moving underwater vehicle by examining the 

AUV’s hydrodynamic coefficients for a range of relative positions and velocities between the 

two vehicles through CFD and experimental work. The motivation behind the study is to 

quantify the hydrodynamic interaction that significantly influences the AUV’s ability to 

safely manoeuvre in close proximity to a submarine and identify a safe operational envelop. 

Thus, the specific research question for this project is: 

 

What are the hydrodynamic interaction effects on an AUV manoeuvring in the proximity 

of a larger moving underwater vehicle? 

 

Due to the previously mentioned challenges associated with CFD, experimental captive 

model tests were carried out in conjunction to validate the CFD models and supplement the 

investigation. Based on the work, the implications of the interaction behaviour on the AUV’s 

safe operating envelope around the submarine, and guiding principles with regard to CFD 

modelling of the problem are presented. 

 

1.2 Description of Geometry Model 
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The smaller (AUV) and the larger (submarine) vehicle models were represented by the 

following geometries. The smaller AUV is represented by the axisymmetric SUBOFF hull 

form (Groves et al. 1989) developed by the Defence Advanced Research Projects Agency 

(DARPA), while the larger body representing the submarine is a modified geometry based on 

the International Submarine Engineer Ltd. designed Explorer (ISE 2005). Figure 1.2 shows 

the geometries of the two vehicles.  

 

 

Figure 1.2: SUBOFF (AUV) and Explorer (Submarine) geometries. 

 

1.3 Methodology 

 

To achieve the outcomes of the study, the research question is addressed through three main 

components: 

 

 a review of the literature on hydrodynamic interaction and its influence on the 

behaviour of multiple underwater vehicles operating in close proximity; 

 development and validation of the CFD simulation model capabilities to capture the 

hydrodynamic characteristics of an AUV with and without the influence of the 

hydrodynamic interaction due to another nearby underwater vehicle; and  

 analysis of the hydrodynamic interaction behaviour on an AUV operating at different 

positions and velocities relative to a larger moving underwater vehicle, including the 

effects of the relative size between the two vehicles on the interaction behaviour. 

 

In order to establish confidence in the accuracy and findings of the latter two components, a 

build-up approach was undertaken. The approach is broken down into the following phases: 
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Phase 1:   Evaluation of the CFD simulation model capability to predict the 

hydrodynamic characteristics of the SUBOFF geometry. 

 

Phase 2:   Development of the CFD model to simulate two underwater bodies in relative 

motion. 

 

Phase 3:  Validation of the hydrodynamic interaction between the SUBOFF and 

Explorer hull forms via scaled-model captive experimental work, including the 

means to extrapolate the CFD model-scale results to full-scale. 

 

Phase 4:  Steady-state analysis of the hydrodynamic interaction effects on the SUBOFF 

hull form at different relative positions to the Explorer hull form, including the 

influence of varying the relative size between the two geometries.  

 

Phase 5:  Transient analysis of the hydrodynamic interaction effects on the SUBOFF 

vehicle when overtaking and being overtaken by the Explorer vehicle at 

different lateral distances and relative velocities. 

 

1.3.1 Assumptions and Limitations of the Investigation 

 

The current study focuses only on the unappended configuration of the vehicles. This allows 

the hydrodynamic interaction between the barehulls of the vehicles to be the focal point of 

the study, thus enabling an unadulterated investigation into the interaction behaviour of the 

two vehicles due to the effects of relative size, position, and velocity between them. The 

study also focuses on the interaction behaviour between the vehicles at a zero incidence angle 

with the flow. The result of this work can then be compared against future work on fully 

appended configurations of the two vehicles at different incidence angles in order to quantify 

the contribution of the appendages and incidence angles to the interaction behaviour.  

 

The test speeds carried out to investigate the interaction behaviour between the vehicles are 

assumed to induce fully turbulent flows around the vehicles (i.e. Re > 1 x 10
6
). They also 

correspond to operating speeds commonly encountered for underwater vehicles (Gertler, 

1950; Joubert, 2006).  
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1.4 Research Considerations  

 

1.4.1 Hydrodynamic parameters 

 

This study focuses on the forces and moments induced on an AUV as a result of the 

hydrodynamic interaction when operating in close proximity to a submarine. The induced 

interaction force and moments are investigated as a function of relative position, size, and 

velocity between the two vehicles in order to characterise the interaction behaviour.  

 

The hydrodynamic force and moments present in this study are based on the local coordinate 

system of the vehicles (see Figure 1.3). The hydrodynamic forces along the directions x, y 

and z are X, Y, and Z respectively, with the corresponding moments being K, M, and N. As 

the flow conditions investigated in this study predominantly aligned with the longitudinal 

axis of the vehicle, the overall length of the vehicle was used as the characteristic length for 

the non-dimensionalisation of the hydrodynamic forces and moments, as well as for Reynolds 

scaling. The equations and notations used in this thesis are defined in the Nomenclature 

Section and is in accordance with the ITTC Symbols and Terminology List (ITTC, 2011b), 

unless otherwise stated. 

 

 
Figure 1.3: Coordinate system and the hydrodynamic forces and moments acting at the 

vehicle’s centre of buoyancy. 

 

1.4.1 Geometrical Considerations 

 

This study aims to investigate the interaction behaviour between an AUV and a conventional 

submarine under full-scale conditions. However, such measurements are difficult to obtain 

using actual vehicles due to the difficulties associated with the availability and accessibility 



 

Chapter 1  Page 9 
 

to such vehicles and the risk of collision damage to the vehicles. Furthermore, experimental 

full-scale model testing is generally prohibitive due to cost and space. Therefore, 

experimental captive scaled model tests were used to validate the CFD models in this study. 

This enabled the validated CFD models to be used for the analysis of the interaction under 

full-scale conditions. An analysis of the validity and reliability of extending the CFD 

simulation from model-scale to full-scale conditions is presented in Chapter 5.  

 

1.5 Novel Aspects 

 

There are three areas in which this project provides original contributions to the field. The 

first is that it is a pioneering study that investigates and quantifies the hydrodynamic 

interaction effects between underwater vehicles in relative motion; in particular an AUV 

operating in close proximity to a larger moving underwater vehicles such as a submarine. 

Although a few studies on the interaction of underwater vehicles exist within the public 

domain, they provide limited contribution, as discussed below. 

 

Bryne (1998) developed a real-time manoeuvring simulator to evaluate and demonstrate the 

manoeuvring and control performance of the Phoenix AUV undertaking a docking operation 

via the torpedo tube of a moving submarine. The hydrodynamic interaction between the two 

vehicles was modelled by introducing a parabolic flow velocity profile along the submarine 

hull in order to represent the reduced flow velocity encountered by the AUV as it approached 

the boundary layer of the submarine. However, this is an over-simplification of the 

interaction effects, since it did not account for operational issues associated with the more 

dominant potential field effects generated by a moving submarine that can either repel or 

attract the AUV depending on their relative positions.  

 

Fedor (2009) investigated a feasible region to conduct a recovery of an UUV by a submarine. 

The study involved three-dimensional (3-D) steady-state CFD simulations of an UUV fixed 

within four regions adjacent to the submarine at different distances from the submarine hull 

as shown in Figure 1.4.  The findings of the study suggest that Region 1 would be the most 

feasible as it offered the least disturbance away from the large trailing wakes of the sail 

present in Regions 3 and 4. The observed repulsion force acting on the UUV as it moved 

closer to the submarine was greater in Region 2 than in the other regions. With regard to the 
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limitations of the study, the simulations were steady-state in nature (i.e. vehicles were 

travelling at the same forward speed and fixed relative positions) and were carried out for 

only four regions relative close to the submarine. Therefore, it is uncertain how far the 

interaction effects extend, and how the interaction effects evolve as the UUV approaches the 

locations at different relative speeds to the submarine 

  

 

Figure 1.4: Positions on a submarine where recovery simulations were carried out by Fedor 

(2009). 

 

The studies by Bryne (1998) and Fedor (2009) offered an insight into the interaction effects 

acting on an AUV operating within the proximity of a larger moving underwater vehicle such 

as a submarine. However, their investigations focused on locations very close to the 

submarine, thus the parameters surrounding the broader extent of the interaction effects (e.g. 

interaction influence of the submarine hull) and the means for the AUV to approach the 

regions investigated were not discussed. Furthermore, their studies were purely simulation-

based, thus lacking experimental data to validate the predictions of the numerical models.  

 

The second original contribution of this thesis is the application of two dynamic meshing 

methods under development within ANSYS CFX, i.e. Immersed Solids and ANSYS Meshing 

Platform (AMP) Remeshing. These methods enable the vehicles within the CFD model to 

undergo large and relative motions, which is not possible using a body-fixed mesh approach. 

While the alogrithms behind the methods have undergone substantial development in recent 

years, there are currently no existing studies demonstrating their capabilities in modelling 

multiple bodies in relative motion, let alone their performance in terms of accuracy. 

Furthermore, the AMP Remeshing method is a beta feature in ANSYS CFX that has yet to be 
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fully integrated into the software, requiring a user-defined script for the method to work. It is 

noted that an alternative fully integrated remeshing method through the ICEM meshing 

module exist within ANSYS CFX. However, the ICEM method handles only translational 

mesh motion. This project presents the underlying concepts behind the methods, the 

evaluation of their performance in modelling underwater bodies in relative motion, and 

guiding principles in utilising the methods. 

 

The third novelty of this project is the interface to couple the ANSYS CFX model with a 

MATLAB-based control system for future work. The coupled model is intended for use in a 

dynamic manoeuvring simulation to develop and trial control strategies for underwater 

vehicles undergoing close proximity manoeuvres before implementation. The nature of the 

CFD-MATLAB coupled environment moves beyond the primary aim of this thesis, and 

hence, demonstration of the environment’s capabilities is presented in Appendix III.  

   

1.5 Outline of Thesis 

 

This thesis follows a “chapterised thesis” structure, where Chapters 2 to 7 comprises of 

scientific papers. The structure of the thesis is outlined below. 

 

Chapter 1: The introductory chapter, which clarifies the research question, objectives, and 

methodology of the project, including a brief description of the issues and past work on the 

hydrodynamic interaction of underwater vehicles. It also outlines the structure of the thesis, 

linking together the subsequent chapters consisting of the academic papers. 

 

Chapter 2: Examines the ability of RANS-based CFD to reproduce the experimentally 

measured forces and moments acting on an unappended SUBOFF geometry undergoing 

steady straight-line and rotating arm manoeuvres at different drift angles, showing that the 

selection of the boundary conditions and turbulence models, and the quality of the mesh 

model can have a considerable and independent effect on the computational results. The 

predictions of two of the most compressive RANS-based turbulence models: Baseline 

Reynolds Stress Model (BSLRSM) and Shear Stress Transport with Curvature Correction 

(SSTCC) are analysed for performance and computational cost, and compared to published 

experimental data for both manoeuvres, showing that with a sufficiently fine mesh, 

appropriate mesh treatment, verification of the simulated flow field, and simulation 
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conditions matching the experiments; the BSLRSM predictions offer good agreement with 

experimental measurements, at a relatively low increase in cost. The SSTCC model 

predictions are agreeable with the longitudinal force but fall outside the experimental 

uncertainty for both the lateral force and yawing moment. The CFD methodology and key 

findings from Chapter 2 are used to provide the basis and support for the more 

comprehensive simulations of the hydrodynamic interaction between the SUBOFF and 

Explorer geometries in the subsequent chapters.  

 

Chapter 3: Introduces the underlying concepts behind the two dynamic mesh techniques 

within ANSYS CFX, i.e. Immersed Solids and AMP Remeshing, and an evaluation of their 

performance in terms of accuracy and computational speed for modelling fluid flow around 

spheres in motion. A comparison of their performance and requirements utilising the Shear 

Stress Transport k-omega (SST k-) and Baseline Reynolds Stress Model (BSLRSM) 

turbulences models as well as a laminar flow model to provide a baseline for computational 

speed comparison are also presented. The computational results were compared to published 

experimental data to benchmark their accuracy and efficiency. Coupled simulations of the 

fluid flow and Rigid Body Dynamics (RBD) solvers were also carried out to investigate the 

accuracy of the motion response predictions compared to analytical solutions for spheres in 

relative motion. The methodology and key findings from this modelling spheres are used to 

build up the CFD capabilities for the more comprehensive simulations of the SUBOFF and 

Explorer geometries in relative motion in Chapter 6.  

 

Chapter 4: Investigates the hydrodynamic interaction effects on the hydrodynamic 

coefficients of the SUBOFF hull form at different relative longitudinal and lateral positions to 

the Explorer hull form. The analysis is conducted at model-scale through a series of steady-

state CFD simulations and captive model experiments in the AMC towing tank. The 

simulations were carried out at different fixed speeds and relative positions for two diameter 

ratios, i.e. 2.237:1 and 13.425:1, by scaling the dimensions of the Explorer geometry while 

keeping the SUBOFF geometry consistent. The higher diameter ratio represents the relative 

size between a typical conventional (SSK) submarine and an AUV, while the lower diameter 

ratio was used for validation against the experimental results. The findings enabled the 

refinement of future two-body interaction simulation models in subsequent chapters, 

including the mesh structure, simulation settings, and analysis techniques. An initial 

assessment of the adverse implications of the interaction effects on an AUV approaching a 
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submarine is also presented, with locations experiencing minimum and maximum interaction 

effects identified. 

 

Chapter 5: This chapter focuses on the analysis of the scaling and relative size effects on the 

hydrodynamic interaction behaviour between the SUBOFF and the Explorer hull forms at 

different relative longitudinal positions and velocities, and at one relative lateral position. The 

experimental results from captive scaled model tests were used to validate the steady-state 

CFD model, taking into consideration experimental limitations. This enables the validated 

CFD models to be used for further analysis of the interaction under full-scale conditions, 

including different diameter to length ratios between the two vehicles representing the 

operation between a typical UUV and a SSK submarine. An analysis of the validity and 

reliability of extending the CFD simulation from model-scale to full-scale conditions is also 

presented. The findings of this chapter provide the basis and support for the full-scale work in 

the subsequent chapters.  

 

Chapter 6: Complements the work presented in Chapter 5 by examining the steady-state 

hydrodynamic interaction effects on the hydrodynamic coefficients of SUBOFF vehicle at 

different relative longitudinal and lateral positions to the Explorer vehicle under full-scale 

conditions. The study is conducted for three vehicles size ratios by scaling the dimensions of 

the SUBOFF geometry as required. The largest ratio represents the typical size ratio between 

an AUV and a SSK submarine. Validation is carried out at model-scale against experimental 

work carried out within the AMC towing tank. The analysis also includes flow visualisation 

to assist in the interpretation of the interaction behaviour. The implications of the interaction 

effects on the ability of an AUV to manoeuvre in close proximity to a submarine are also 

discussed.  

 

Chapter 7: Presents the transient analysis of the hydrodynamic interaction effects on an 

AUV operating in close proximity and in relative motion to a larger moving submarine. The 

effects of relative motion on the interaction behaviour were investigated via two manoeuvres, 

i.e. the AUV overtaking and being overtaken by the submarine at different relative forward 

velocities and lateral distances. The SUBOFF and Explorer hull forms are used to represent 

the AUV and submarine respectively. The results presented are from a series of transient 

CFD simulations utilising the AMP Remeshing technique to model the vehicles in relative 

motion. Validation of the transient CFD model is carried out through captive scaled model 
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experiments. The results provide information on options to reduce the effects of the 

interaction on the AUV. An analysis of the AUV’s control planes’ ability to effectively 

manoeuvre under the influence of the interaction is also presented.  

 

Chapter 8: The concluding chapter provides an overall summary of the project, bringing 

together the findings of the individual chapters. It also concludes on the findings and 

outcomes, as well as discussing the implications of the findings, the limitations, and the 

recommendations to meet the project requirements and for future work. 

 

Appendices: Appendix I outline the uncertainty analysis of the experimental data for 

Chapters 4 to 7. Appendix II provides information on the setup of the AMP Remeshing 

method to model the vehicles in relative motion. Appendix III describes the setup and 

provides a demonstration of the interface to control the simulation of the vehicles in relative 

motion through a MATLAB environment. 



Chapter 2 Page 15 

Chapter 2 :  

RANS-based CFD Prediction of the 

Hydrodynamic Coefficients of DARPA 

SUBOFF Geometry in Straight-Line and 

Rotating Arm Manoeuvres 

This chapter has been accepted for publication in the “Transactions of the Royal Institution of 

Naval Architects, Part A1 – International Journal of Maritime Engineering” and at the time of 

writing will be published at the first available issue of the journal. The citation for the 

research article is: 

Leong, Z.Q., Ranmuthugala, D., Penesis, I., & Nguyen, H. 2014, ‘RANS-Based CFD 

Prediction of the Hydrodynamic Coefficients of DARPA SUBOFF Geometry in Straight-

Line and Rotating Arm Manoeuvres’, Transactions RINA: Part A1- International Journal 

Maritime Engineering. [Accepted for publication, 20 September 2014]  

This chapter has been removed for
copyright or proprietary reasons.
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Chapter 3 :  

Dynamic Simulation of Two Bodies in Relative 

Motion 

This chapter consists of two subchapters: 

Part A- Computational Fluid Dynamics Re-Mesh Method to Generate Hydrodynamic 

Models for Manoeuvring Simulation of Two Submerged Bodies in Relative 

Motion. 

Part B- Numerical Simulation of Spheres in Relative Motion Using Dynamic Meshing 

Techniques. 
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Chapter 3 :  

Part A - 

Computational Fluid Dynamics  

Re-Mesh Method to Generate Hydrodynamic 

Models for Maneuvering Simulation of Two 

Submerged Bodies in Relative Motion

This subchapter has been published in the Journal of Computer Science and Cybernetics. The 

citation for the research article is: 

Leong, Z.Q., Ranmuthugala, D., Penesis, I., & Nguyen, H. 2011, ‘Computational Fluid 

Dynamics Re-Mesh Method to Generate Hydrodynamic Models for Manoeuvring Simulation 

of Two Submerged Bodies in Relative Motion’, Journal of Computer Science and 

Cybernetics, vol. 27, no. 4, pp. 353-362. 
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Abstract 

An Autonomous Underwater Vehicle (AUV) operating closer to a larger vessel experiences 

significant hydrodynamic forces requiring an adaptive control mechanism to maintain 

acceptable trajectory. It is therefore important that the designer understands the 

hydrodynamic characteristics of the vehicle in this scenario in order to develop appropriate 

control algorithms to deal with its dynamic behaviour. This requires developing simulations 

of the vehicle’s behaviour close to the larger vessel, the control algorithms, and the dynamic 

interface between the two. 

This paper presents a method to generate a complete hydrodynamic model of underwater 

vehicles using the Computational Fluid Dynamics (CFD) code ANSYS CFX, which can then 

be interfaced with the vehicle’s control algorithms within a simulation environment. The 

essential aspect of the method is the re-mesh approach, where the mesh deforms locally 

around the bodies using an Arbitrary Lagrangian-Eulerian form of the governing fluid 

equations and re-meshes when the deformation significantly compromises the quality of the 

mesh. This overcomes the motion limitations imposed by a pure deforming mesh approach. 

Preliminary work to validate the method is based on two smooth spheres moving relative to 

each other. It is found that this method is able to adequately simulate the fluid behaviour 

around the bodies. The paper also describes the future work focused on a 6-DOF AUV 

modelled in CFD to obtain its hydrodynamic behaviour to be interfaced to the control system 

within MATLAB.  
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3A.1  Introduction 

 

When an AUV is operating close to a larger vessel such as a submarine or a surface ship, the 

hydrodynamic interactions between the two can be significant. Given that the AUV is 

relatively small, this interaction can adversely affect its trajectory, which in extreme cases 

can cause collision or loss of the vehicle. Therefore, it is essential that the AUV’s control 

system is sufficiently robust and adaptive to deal with rapidly varying pressure and velocity 

fields around the vehicle (Figure 3A.1).  

 

 

Figure 3A.1: Interaction between vehicles (Saab 2012). 

 

In order to quantify the interaction between the two vehicles, it is required to conduct 

numerical and/or experimental work to obtain their hydrodynamic characteristics during 

operations in close proximity. One method of numerically obtaining this is to conduct CFD 

simulations of the vehicle manoeuvres to predict the resulting forces and moments, which 

will characterise the behaviour of the vehicles. This can then be fed into the control system 

simulation to develop the necessary algorithms to maintain the required trajectory. 

  

To date, many of the numerical approaches to simulate the hydrodynamic characteristics 

adopt a body fixed mesh to simulate the flow around a body moving in 6 degrees-of-freedom 

(6-DOF). The fluid domain mesh is rigid and moves in 6-DOF with the body (Figure 3A.2). 
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However, this approach is not suitable for simulation of two bodies in relative motion since 

the bodies are fixed at a location relative to the fluid domain. 

 

 

Figure 3A.2: Body fixed mesh simulation. 

 

This paper describes the implementation of the re-mesh method which theoretically allows an 

arbitrary number of bodies in relative motion to be simulated. (Note: an example of CFD 

mesh used in the current simulation is shown in Figure 3A.5. The main purpose of this paper 

is to: 

 

 present the underlying theory behind the re-mesh method and its implementation for 

6-DOF simulations; 

 outline the solution procedure of the simulation; and 

 provide preliminary results of the method in terms of accuracy. 

 

3A.2  Fluid Equation of Motion 

 

The CFD re-mesh method requires an Arbitrary Lagrangian-Eulerian (ALE) form of the 

governing fluid equations to accommodate the deformation in the mesh and requires only the 

one apparent body force term for the linear accelerations. The ALE formulation allows the 

mesh motion to be defined independent of the motion of the fluid being analysed.   

 

The mass momentum equations in ALE form are as shown below, where calculation of the 

mesh velocity umj is based on the domain boundary movement of the body. 
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Mass conservation: 
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Momentum: 
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where stable forces on the body Fs is  
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and the apparent body force Fb is  
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To account for the deforming mesh, the turbulence equations are also in ALE form:  

 

k-equation: 

 

  (3A.5) 

 

ω-equation: 

 

(3A.6) 
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Details on the turbulence model source terms are available in ANSYS (2011). An additional 

set of mesh displacement Laplace equations is added to solve the ALE formulation. The 

Laplace equations diffuse boundary motion into the interior of the fluid domain. The resulting 

solution, obtained by integrating over the time interval, allows for the extraction of the mesh 

velocity umj. The set of Laplace equations is as follows: 

 

Mesh displacement equations: 

 

0
 
  
   

i

j j

x

x x



    (3A.7) 

 

where 

 

0  i i ix x x
     (3A.8) 

 

The displacement diffusion coefficient   can be a function of near wall distance or mesh 

volume size. 

 

3A.3  Body Equations of Motion 

 

The set of equations described below is used to illustrate the coupling of the body equations 

of motion with the fluid equations of motion in ALE form for a 6-DOF simulation (Dajka et 

al. 2007). The body equations of motions, based on a translating coordinate system fixed to a 

submerged body and are as follows:  

 

General equation of motion: 

 

 GF mu
     (3A.9) 
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        O G G
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   (3A.11) 

 

The moments of inertia are functions of time and evaluated at each new time interval where, 

 

   ̇𝜔     𝛼  
       

  
     (3A.12) 

 

This allows a system of equations to be solved to track the motion of the body, where axial 

(x-axis), lateral (y-axis), and normal (z-axis) forces are, 

 

𝑚  ̇ −     
           −  ̇         ̇              (3A.13) 

 

𝑚  ̇ −     
           −  ̇         ̇                       (3A.14)  

 

𝑚  ̇ −     
           −  ̇         ̇                     (3A.15) 

 

with the force vectors obtained from the stable and apparent forces. Similarly rolling (x-axis), 

pitching (y-axis) and yawing (z-axis) moment are, 

 

   ̇ −     ̇ −     ̇ −   ̇ −   ̇  −   ̇   𝑚    ̇ −    ̇                (3A.16) 

 

   ̇ −     ̇ −     ̇    ̇ −   ̇  −   ̇   𝑚    ̇ −    ̇              (3A.17) 

 

   ̇ −     ̇ −     ̇    ̇ −   ̇  −   ̇   𝑚    ̇ −    ̇                (3A.18) 

 

This results in a matrix system: 

 

 (3A.19) 
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The solution of the matrix system results in estimates at the new time level of accelerations 

( ̇  ̇  ̇  ̇  ̇  ̇), which in turn with the known time step allow for calculation of velocities 

(           ). 

 

The auxiliary derivatives in the inertial frame ( ̇   ̇   ̇   ̇   ̇   ̇   ̇  ̇  ̇  is then integrated 

to obtain the new position and angular movement (              ). 

 

3A.4  BODY EQUATIONS OF MOTION 

 

3A.4.1 CFD Re-Mesh Method 

 

The essential aspect of the method is that the mesh in the fluid domain deforms locally 

around the body as it moves, and re-meshes when the mesh quality is deemed poor. The 

simulation information from the previous mesh is interpolated into the new mesh. The re-

mesh process is summarized in the flowchart given in Figure 3A.3.  

 

 

Figure 3A.3: Flowchart of the re-mesh method process. 
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The interrupt conditions, e.g. mesh quality below a predetermined threshold, to initiate 

remeshing script is defined in the solver control. The process of the remeshing script is 

summarized into five main parts: 

 

 Part 1: Opens ANSYS WorkBench (WB) project component. 

 Part 2: Extract monitor data from current the time step. 

 Part 3: Override values of WB parameters for the geometry and mesh based on 

monitor data. 

 Part 4: Recreate geometry and mesh. 

 Part 5: Replace mesh, interpolate solution on new mesh, continue solver run. 

 

3A.4.1.1 Limitations 

 

The method requires separate preprocessing and meshing setups. The remeshing component 

is also not integrated in CFX and requires the user defined remeshing script to transfer the 

displacement in WB for the re-creation of the geometry and mesh. 

 

3A.4.2 Solution Process 

 

The solution procedure involves iterating within a time step to obtain the average force and 

moment conditions over the time step that result in a new predicted velocity state for the next 

time step.  

 

Within a time step, the hydrodynamic variables are recomputed providing a new set of forces 

and moments to use in the body equations of motion. The repetition of the iterations 

(coefficient loops) and re-evaluation of the body state is continued until the RMS residuals in 

the fluid equations are reduced below a specified limit. The solution process is summarized in 

the flowchart shown in Figure 3A.4.  
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Figure 3A.4: Flowchart of the solution procedure 

 

3A.5  Results 

 

The current development work focused on the re-mesh method. The coupling of the fluid 

equations of motion with the body equations of motion as described in Section 3A.3 and 

Section 3A.4 will be incorporated in future work for a full 6-DOF AUV simulation 

manoeuvring close to a larger vessel. The simulation presented in this paper examines the 

accuracy of the re-mesh method to predict the flow around the bodies.   
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To validate the re-mesh method, two identical smooth spheres are considered as shown in 

Figure 3A.5. The simulation case is described below. 

 

 

Figure 3A.5: Mesh of two spheres (re-mesh) 

 

Simulation Case 

Two spheres, Sphere 1 and Sphere 2, are to maintain position parallel to a free stream of Re = 

1x10
4
 for 2 seconds. Sphere 2 maintains position throughout simulation to serve as a control. 

At simulation time, t = 2s, Sphere 1 moves forward in the x-direction under a prescribed 

acceleration, increasing at a rate of 0.179m/s
2
 per second, for 3 seconds.  

  

Figure 3A.6 and Figure 3A.7 show the X forces on the two spheres plotted in comparison to 

the experimental results by Morrison (2010). As seen by the results, the general trend is well 

replicated.  However, there are some issues in capturing certain aspects of the force curve, 

such as the ‘dip’ experienced in Morrison’s curve for the moving sphere as its velocity 

increases and the boundary layers transits from laminar to turbulent. This will require further 

refinement to the mesh and the model settings. 

 

  

Figure 3A.6: Sphere 1 (moving) – computed 

force X 

Figure 3A.7: Sphere 2 (stationary) – 

computed force X 
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The CFD forces on the stationary body in Figure 3A.7 are relatively close to the experimental 

results. The spike exhibited in the CFD results represents the remeshing, as the solver has to 

re-establish convergence.  

 

(Note: The magnitude of the spike have been substantially reduced through improvements to 

the re-mesh algorithm and further reduced through a median filter in the results presented in 

the subsequent chapters) 

 

3A.6  Conclusion 

 

AUVs operating close to larger surface and submerged vessels will require simulations of 

both the hydrodynamic behaviour and the adaptive control system to enable proper design of 

the vehicle. The two components of the simulation need to be interfaced to enable the 

designer to understand the response of the vehicle due to the interaction between the AUV 

and the vessel.  

 

The paper described the simulation of two underwater bodies moving relative to each other to 

provide hydrodynamic data to feed into the AUV control system simulation. Initially this 

consisted of two spheres; however, this will be expanded to simulate a 6-DOF AUV and a 

submerged moving vessel. The process employed is the remeshing method in ANSYS-CFX, 

which provided promising results in comparison to experimental data. This method is being 

improved to provide faster real time data linked to a MATLAB control environment 

replicating the AUV’s control algorithm. 
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Chapter 3 :  

Part B -  

Numerical simulation of spheres in relative 

motion using dynamic meshing techniques 

 

This chapter has been published in the Proceedings of the 18
th

 Australasian Fluid Mechanics 

Conference. The citation for the research article is: 

 

Leong, Z.Q., Ranmuthugala, D., Penesis, I., & Nguyen, H. 2012, ‘Numerical Simulation of 

Spheres in Relative Motion Using Dynamic Meshing Techniques’, Proceedings of the 18th 

Australasian Fluid Mechanics Conference, 3-7 December 2012, Tasmania, pp. 1-4.  
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Abstract 

 

The commercial Computational Fluid Dynamics (CFD) code ANSYS CFX was used to 

simulate the flow around three dissimilar spheres in relative motion over a large range of 

Reynolds numbers (Re) from 10
2
 to 10

6
. The simulations utilise a six degrees-of-freedom 

Rigid Body Dynamics (RBD) solver to predict the motion of spheres in response to external 

forces. The simulations were intended to provide a benchmark of the code in its ability to 

accurately predict the flow around multiple submerged bodies, such as submarines and 

unmanned underwater vehicles (UUV) in relative motion.  The simulations were found to be 

in good agreement with both experimental data for the drag predictions and analytical 

solutions for the simulated motions. 

 

Due to the large relative motions between the spheres, the CFD simulation domain undergoes 

significant deformation, requiring dynamic meshing techniques to maintain the integrity of 

the mesh and solution. A number of options including mesh deformation and adaptive 

remeshing, immersed solids, turbulence models, and the interface with the RBD solver were 

evaluated to optimise the time and resource utilisation, while maintaining acceptable 

accuracy and stability. The study identifies the merits of the different options to simulate 

multiple bodies in relative motion and provide time dependent hydrodynamic data at 

sufficient accuracy and speed to enable dynamic coupling with a control system for 

manoeuvring simulation of underwater vehicles.   
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3B.1  Introduction 

 

When an UUV is operating in proximity to a larger vessel, interaction with the wake and 

pressure field generated by the latter can impose rapid acceleration changes on the UUV. 

This can cause the vehicle to undergo uncontrollable oscillations which in extreme cases can 

result in collision or loss of the vehicle. Therefore, it is important for designers to have a 

good understanding of the vehicle’s behaviour under the effects of the interaction. This will 

enable designers to: develop control systems that are sufficiently robust enough to deal with 

the changes in acceleration, improve the hydrodynamic performance of the vehicle, and 

establish safe operating envelopes. 

 

In general, the hydrodynamic characteristics of underwater vehicles can be evaluated and 

quantified through experimental and empirical methods such as captive model testing and 

actual vehicle trials. However, these methods require considerable cost and time, and are 

restricted by the availability of suitable physical models of the vehicles and appropriate test 

facilities. For multi-body investigations the cost can increase up to three times that for a 

single body due to the complexities involved in the experimental setup (Park et al. 2008).  

 

Ongoing development of high performance computing facilities and numerical codes to 

predict fluid flow and pressure fields has enabled computer based simulations using CFD to 

replicate conditions that are difficult or costly to achieve through experimental processes. 

One of the major challenges faced when using CFD as an analysis tool for hydrodynamics is 

that computational results can vary greatly depending on the experience of the analyst, the 

setting utilised such as the boundary condition and the turbulence models, and the quality of 

the mesh grid. However, by combining both computational and experimental work, a 

validated simulation model could be obtained and used with confidence over the wider 

analysis range. This approach would be a more cost effective, faster, and viable alternative 

compared to one that is purely dependent on experimental work. 

 

The flow past a sphere was chosen as a starting point for this study as there is extensive 

literature on its characteristics. Most numerical investigations on fluid flow around a sphere 

have been focused on using higher order schemes such as Large Eddy Simulation (LES) and 

Direct Numerical Simulation (DNS). These schemes have produced high quality and accurate 
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predictions of the wake structure, shedding frequencies, and forces associated with a flow 

within a Re range between 10
2 

and 10
6
 (Jones & Clarke 2008; Beratlis et al. 2012). Despite 

extensive numerical studies on sphere hydrodynamics, there appears to be limited work using 

Reynolds-Averaged Navier-Stokes (RANS) simulations.  

 

In RANS simulation, all scales of turbulence are modelled and the transport equations are 

represented in mean flow quantities. Although, this approach is less accurate for time 

dependent flow phenomena, e.g. vortex shedding, it offers a viable means to obtain 

reasonably accurate hydrodynamic forces acting on a submerged body in motion at greatly 

reduced computational effort. The reduction in mesh requirements for RANS simulation can 

be up to 10
3
 orders of magnitude compared to an LES mesh of ~10

9
 cells for equivalent 

accuracy (Menter 2012). In addition, the required time step for stability in RANS is 

determined by the fluctuation in the mean flow rather than turbulence. This allows RANS 

simulation to be carried out at time step of up to 100 times coarser than LES, especially for 

transient simulation with turbulent flows. 

 

 

Figure 3B.1: CFD visualisation of the velocity field and streamlines around a sphere in 

motion. 

 

In this study, two dynamic mesh techniques, Mesh Deformation and Adaptive Remeshing 

Method (MDARM) and Immersed Solid Method (ISM) are evaluated in terms of accuracy 

and computational speed for modelling fluid flow around a single smooth sphere in motion 

over a Re range of 10
2 

to 10
6
. The MDARM simulations (see Figure 3B.1) were carried out 
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with the Shear Stress Transport k-omega (SST) and Baseline Reynolds Stress Model 

(BSLRSM) turbulences models in addition to a laminar flow model providing a baseline for 

computational speed comparison. The ISM simulations were carried out with the SST model. 

The computational results were compared to experimental data to benchmark their accuracy. 

Coupled simulations of the flow and RBD solvers were also carried out to investigate the 

accuracy of the motion predictions compared to analytical solutions for three spheres in 

relative motion. The aim of the study was to establish which combination of turbulence 

model and dynamic meshing technique offered an efficient trade-off between accuracy and 

computational speed.  

 

3B.2  Numerical Model 

 

3B.2.1 Single Sphere Model 

 

The three-dimensional (3D) computational domain is presented in Figure 3B.2. The size of 

the domain was 10m long, 2m wide and 2m deep. The diameter of the sphere was 0.1m. The 

sphere was located at an initial position 2m forward of the Outlet boundary and 1m away 

from the Farfield boundaries to ensure the pressure field generated by the sphere was well 

within the computational domain.  

 

The MDARM simulations were carried out on an unstructured mesh containing 5.910
5
 cells, 

made up of tetrahedrons in the regions away from the sphere and prisms around the sphere to 

capture the boundary layer as shown in Figure 3B.3. The sphere resides in a subdomain 

which allows the mesh within subdomain to be rigid, with deformation occurring only in the 

outer fluid domain. The mesh was progressively refined by subdividing the cells of the sphere 

surface and subdomain to examine the sensitivity of the drag predictions to the mesh density. 

At 710
6
  cells, the variation in the predicted mean drag of the sphere was 6% compared to 

the 5.910
5
 mesh cells model with the SST model at Re = 10

6
. Therefore, the latter mesh 

model was deemed sufficiently mesh independent with an uncertainty of 12% (26%). 

Further refining the mesh would result in the simulations being too expensive for coupling 

with a control system, as a smaller time step is required for smaller cells in order to satisfy 

the Courant-Friedrichs-Lewy (CFL) numbers of below 10 across the domain. 
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Figure 3B.2: The single sphere computational domain. 

 

 

Figure 3B.3: The MDARM mesh model. 

 

For the evaluation of the ISMs simulations, the mesh for the sphere and fluid domain were 

individually generated and then overset as shown in Figure 3B.4. The mesh model of the 

sphere consists of the inner volume which requires only good mesh resolution on the sphere 

surface, e.g. mesh surface area error of less than 1%. The volume mesh inside the sphere may 

be arbitrarily coarse. The fluid mesh cells in which the sphere travels were refined to half the 

sphere surface mesh size to ensure two fluid domain nodes to every sphere domain node exist 

at the boundaries where the two domains intersect. This is required to ensure stability and 

smooth interpolation between the nodes of the fluid domain and the sphere. The result is a 

mesh model of approximately 710
6
 cells.  
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Figure 3B.4: The ISM mesh model; sphere mesh (upper left), fluid domain mesh  

(bottom left). 

 

3B.2.2 Two Spheres Model 

 

Two spheres with a diameter 0.1m were located within a computational domain size of 3m 

long, 2m wide, and 12m deep as shown in Figure 3B.5. The initial locations of the spheres 

were at z = -10m, 1m apart from each other, and 1m away from the Farfield boundaries. The 

mesh setup of the spheres was identical to the single sphere MDARM model. The mesh size 

was approximately 1.210
6
 cells. 

 

 

Figure 3B.5: The two spheres computational domain.  
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3B.3  Numerical Simulation 

 

The simulations were performed using the CFD code ANSYS CFX v14, which uses a control 

volume based finite element discretisation scheme. A time step between 0.1ms-1ms was used 

throughout the simulations in order to provide reasonably good time resolution of the forces 

and motions while maintaining CFL numbers of below 10 in the majority of the 

computational domain. The density and kinematic viscosity of the fluid were 997kg/m
-3

 and 

8.89910
-4

m
2
/s respectively. 

 

3B.3.1  Single Sphere Simulations 

 

The essential aspect of the MDARM is that the mesh in the fluid domain deforms locally 

around the sphere as it moves and remeshes when the mesh quality is deemed compromised 

in terms of accuracy and stability. This overcomes the limited motions imposed by using a 

pure mesh deformation approach. Although mesh deformation is fully supported in ANSYS 

CFX, the remeshing component is a beta feature and requires the use of a user-defined script. 

The latter, triggered by the mesh quality criterion, interrupts the simulation and transfers the 

positional state of the sphere into ANSYS Workbench in order to update the geometry and the 

mesh. The script then transfers the new mesh into the solver where the simulation 

information from the previous mesh is interpolated into the new mesh and the simulation is 

resumed. The mesh quality criterion was defined as the orthogonality angle in the mesh cells 

of no less than 10°.  

 

For the ISM simulations, the sphere is defined as an immersed solid. As the sphere moves 

within the fluid domain, the velocity of the fluid nodes is enforced to be same as the velocity 

of the sphere by applying a set of source terms in the regions where the sphere mesh overlaps 

the fluid domain mesh. This method essentially avoids any mesh deformation, therefore 

remeshing is not required. The simulations were carried out with the SST turbulence model to 

model the turbulence in the freestream and the regions affected by the pressure field of the 

sphere. The ISM method does not resolve the boundary layer due to the inability to apply a 

wall treatment on the surface of the sphere.  
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3B.3.2  Two Spheres Motion Response Simulations 

For the motion response simulation, the flow solver was coupled with the RBD solver using 

the MDARM for modelling the relative motion between spheres. The spheres were 

submerged at an initial depth of 10m and were allowed to rise up freely. Different mass 

values were defined for each of the spheres, with the motion of each sphere dictated by the 

net force of its weight and buoyancy. The properties of the spheres are outlined in table 1. 

 

Table 3B.1: Properties of the spheres for the motion response simulation. 

Sphere S1 S2 

Mass, m [kg] 4.568E-1 3.915E-1 

 

3B.4  Results and Discussion 

 

3B.4.1  Single Sphere Results 

 

Figure 3B.6 shows the mean drag coefficient (CD) predictions of the MDARM simulations 

with SST, BSLRSM and Laminar model and the ISM simulations with SST against the 

experimental results by Schlichting (1979). 

 

 

Figure 3B.6: Mean drag coefficient of the single smooth sphere as a function of Re. 

 

At Re < 10
3
, where the flow around the sphere is below the turbulence wake regime, the ISM 

and the MDARM predictions compares favourably with the experimental results. The 
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predictions of the MDARM-SST model and MDARM-BSLRSM were within 5% of the 

Laminar model. Although this is counterintuitive when turbulence models are applied for 

laminar flow since the boundary layer is modelled to be fully turbulent, the SST and 

BSLRSM are able to handle very small turbulence kinetic energy in the flow field thus able 

to give similar predictions to the Laminar model within the regime.  

 

At 10
3 

< Re < 10
4
, the wake behind the sphere changes from laminar to turbulent, while its 

boundary layer remains laminar. The drag predictions of all models were in good agreement 

as shown in Figure 3B.6. At Re = 10
4
, the MDARM-SST model increasingly underpredicts 

the sphere drag as Re increases. The same was observed for the MDARM-BSLRSM drag 

predictions at Re ~610
4
 onwards. This is possibly due to the models overpredicting the 

turbulence kinetic energy in the sphere boundary layer thus pushing its separation further 

back. The predictions of MDARM-Laminar model and the ISM-SST model were found to be 

in good agreement with experimental results. It is noted that the predicted mean drag 

coefficient by the ISM-SST model remains around 0.5 as Re increases thereafter.  

 

At 10
5
 < Re < 10

6
, the flow in sphere boundary layer transitions from laminar to turbulent 

causing a sudden drop in drag which is commonly referred as the ‘drag crisis’. None of the 

models were able capture the drag crisis characteristics. This was expected as none of the 

models were designed for transitional flows. However, the MDARM used with turbulence 

models were able to exhibit a gradual decline in drag within the regime and gave good 

predictions when the flow was fully turbulent at Re = 10
6
. Both the MDARM-Laminar and 

ISM-SST models were unable to accurately predict the drag on the sphere for turbulent 

boundary layer dependent flow.  

 

The MDARM simulations were carried out with 6 core processers, and the ISM simulations 

16 core processers due to its high mesh density. Table 2 outlines the computational effort of 

the simulations at Re = 10
6
. The time for each remeshing event in the MDARM simulations 

was approximately 50 seconds. Although the MDARM-Laminar required the least 

computational effort, the model was insufficiently accurate for flow speeds where turbulence 

is prevalent. The MDARM-BSLRSM drag prediction was the most accurate, 11% closer to 

experimental results compared to MDARM-SST, however, the former required 42% more 

computation effort. Therefore, the MDARM-SST model was reasoned to be the most 



 

Chapter 3 – Part B  Page 65 
 

efficient in terms of accuracy and computational speed. The ISM was the most computational 

expensive option in both mesh requirement and computational time. Although the ISM does 

not require remeshing, the advantage was offset by the fine mesh required in regions where 

the sphere travels to maintain simulation stability resulting in a substantial increase in mesh 

density. The ISM is more suited for simulations of bodies undergoing localised rotational 

motion or medium displacement. 

 

Table 3B.2: Computational effort of the simulations at Re = 10
6
.  

Model Mesh cells Time per inner loop [s] Effort compared to 

MDARM-Laminar 

MDARM-Laminar 610
5 24 1.00 

MDARM-SST 610
5
 29 1.20 

MDARM-BSLRSM 610
5
 41 1.70 

ISM-SST 710
6
 400 194 

 

3B.4.2  Two Spheres Results 

 

The simulation results for the linear acceleration of the spheres, were found to be in good 

agreement with the analytical solution,  ̈ , which was based on Newton’s second law of 

motion,. The simulation result for the linear acceleration of S1 was 0.866m/s
2
 while the 

analytical result was 0.892m/s
2
, giving an error of 3%. For S2, the simulation result was 

1.803m/s
2
 with the analytical result being 1.962m/s

2
, giving an error of 8%.  

 

 

Figure 3B.7: The z-displacements of the two spheres. 
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Figure 3B.7 shows the simulation results for the z-displacement of the two spheres plotted in 

comparison to the analytical results. The analytical results were obtained by twice integrating 

 ̈  with respect to time. The simulation results underpredicted the motions compared to the 

analytical results but were within 10% of the latter. This was considered acceptable as the 

analytical results did not take into account the fluid drag acting on the spheres.  

 

3B.5  Conclusion 

 

The present work is directed towards developing a simulation environment of an underwater 

vehicle manoeuvring in relative motion to a larger vessel, with the extensibility for coupling 

with the vehicle’s control system. The simulation model needs to provide time dependent 

hydrodynamic data of reasonable accuracy and sufficient speed to enable efficient coupling 

with the control system for manoeuvring simulations of underwater vehicles. 

 

The performance of RANS-based simulations with and without turbulence models, coupled 

with the dynamic mesh techniques, to simulate the fluid flow around a sphere undergoing 

large displacements within 10
2 

< Re < 10
6
 were examined. The MDARM-SST model was the 

most efficient in terms accuracy and computational speed with the drag predictions of the 

model being in good agreement with experimental data, except for within the flow regime 

where the sphere boundary layer changes from laminar to turbulence. The MDARM-

BSLRSM predictions were 11% closer to experiment at fully turbulent flow at Re = 10
6 

compared to the SST model but took 42% more computational time. 

 

The MDARM was found to be far superior for modelling bodies with large displacement 

compared to the ISM in both accuracy and computational effort. Although the ISM does not 

require remeshing or a mesh to resolve the boundary layer around each body, it still requires 

a fine mesh in the fluid domain regions where the body travels. This fine mesh increases 

substantially with the motion range thus also increasing computational time. In addition, the 

inability of the ISM to model the boundary layer accurately has shown to give poor drag 

predictions at higher flow speeds. The motion predictions of the coupled flow solver and 

RBD solver simulations for two spheres in relative motion were found to be in good 

agreement to analytical solutions. 
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Currently, work is being carried out to model a 6-DOF UUV and a larger submerged vessel 

in relative motion, which requires simulation of the vehicle’s hydrodynamic behaviour close 

to the larger vessel. The simulation model is also being improved to provide faster real time 

data linked to a MATLAB-based control environment replicating the UUV’s control 

algorithm. In conjunction with the numerical work, experimental model tests are being 

carried out to validate the capability of the simulation to predict the hydrodynamic interaction 

between the UUV and the larger vessel. 
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Abstract 

 

When an Autonomous Underwater Vehicle (AUV) operates close to a submarine, interaction 

with the flow and pressure fields of the submarine can adversely affect the motion of the 

AUV. These interactions can result in uncontrollable motions of the AUV, which in extreme 

cases can lead to mission failure due to the inability of the AUV to maintain the desired 

trajectory or from collision with the submarine. This paper outlines the steady-state 

interaction forces and moments acting on the AUV at different fixed speeds and relative 

positions to the submarine, with an aim to identify the regions where adverse effects due to 

interaction are minimal. The results presented in this paper are from a series of model scale 

and full-scale Computational Fluid Dynamics (CFD) simulations on axisymmetric AUV and 

submarine models at diameter ratios between the two vehicles models of 2.239, 5.723 and 

14.634. Validation was carried out for the lower diameter ratio at model scale using captive 

model experiments. Results show that the adverse effects of the interaction forces and 

moments were minimal when the AUV’s centre of buoyancy is around amidships of the 

submarine, providing a relatively safe operating path for the AUV. 
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6.1  Introduction 

 

The increasing capabilities of Autonomous Underwater Vehicles (AUVs) have resulted in 

greater usage of AUVs within both the civilian and the defence sectors in potentially 

hazardous environments for long periods of time with no real-time user intervention. One 

such area is the operation of an AUV in close proximity to a moving submarine, requiring the 

AUV to safely negotiate the hydrodynamic interaction effects between the two vessels. These 

interaction effects are of particular interest to submarine and AUV designers as navies around 

the world begin to equip their submarine fleets with the capability to launch, retrieve and 

recharge AUVs, in addition to the ability to communicate data between them during 

operations (Rodgers et al. 2008; Hardy & Barlow 2008; DARPA 2013). Currently, there is 

very little information with regard to this in the public domain.  

 

 

Figure 6.1: An AUV moving in the wake of a submarine. 

 

When an AUV is operating close to a moving submarine (see Figure 6.1), interaction with the 

submarine’s wake and pressure fields can impose unwanted forces and moments on the AUV. 

These interaction effects can cause the AUV to undergo uncontrollable motions which can 

result in mission failure due to the vehicle’s inability to maintain its desired trajectory and in 

extreme cases lead to collision with the submarine, resulting in the damage or destruction of 

the AUV and possible damage to the submarine appendages or sensors (Byrne 1998). Since 

the AUV is relatively small compared to the submarine, it would be the principle vessel 

adversely affected by the interaction. Thus, designers need to have a good understanding of 

the hydrodynamic interaction between the two vehicles in order to develop AUV control 
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systems that can ensure vehicle stability and identify operating parameters in which an AUV 

can effectively manoeuvre near a submarine. 

  

A recent study was carried out numerically by Byrne (1998), based on a real-time 

manoeuvring simulator developed by Brutzman (1994) to evaluate the manoeuvring and 

control performance of an AUV in response to steady-state ocean currents. Byrne (1998) 

attempted to extend the simulator capabilities to include flow forces induced by an adjacent 

submarine. The aim of the simulation was to evaluate the manoeuvring and control 

performance of the Phoenix AUV undertaking a docking operation with a 688-class 

submarine via a retractable recovery tube located at the front end of the submarine parallel 

midsection. The hydrodynamic interaction between the two vessels was included in a module 

which is based on Ludwig Prandtl’s classical boundary layer theory for a flat-plate. The 

module introduced a parabolic flow velocity profile along the submarine hull in order to 

represent the reduced flow velocity encountered by the AUV as it approached the boundary 

layer of the submarine. However, this is an over-simplification of the interaction effects, as it 

did not account for operational issues associated with the submarine wake effects and the 

more dominant potential field effects generated by the submarine which can either repel or 

attract the AUV depending on their relative positions.  

 

Using steady-state Computational Fluid Dynamics (CFD) simulations, Fedor (2009) 

investigated the hydrodynamic interaction effects on an AUV at a fixed position relative to 

the sail of a moving submarine. The aim of the study was to establish a feasible region to 

launch and recover the vehicle around the submarine. It was found that in the forward region 

of the sail the interaction acts to repel the underwater vehicle, with the repelling force 

increasing as the vehicle gets closer to the submarine. General trends were less observable in 

the regions to the side and astern of the sail, where the direction of the force and moments 

acting on the vehicle fluctuate due to the horseshoe vortices generated by the sail. Since the 

investigation focused on locations very close to the submarine, the parameters surrounding 

the broader extent of the interaction effects and the means for the AUV to approach the 

regions were not discussed. 

 

To date, there have been very few experimental studies investigating the hydrodynamic 

interaction between two submerged vessels. The studies by Byrne (1998) and Fedor (2009) 

offer an insight into the interaction effects acting on an AUV operating within the proximity 
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of a larger moving underwater vessel. However, they both state that their results were based 

purely on numerical work, requiring adequate validation. 

 

For experimental methods, the hydrodynamic characteristics of AUVs can be evaluated and 

quantified through captive model testing or in-water testing of the actual vehicle. However, 

these methods require considerable cost and time, and the requisite of a physical model of the 

vehicle and suitable test facilities. For multi-vehicle investigations, the cost can increase 

substantially for each additional vehicle involved due to complexities in the test setup, in 

particular for an AUV operating within the proximity of a larger moving underwater vessel. 

As such, the hydrodynamic interaction effects between submerged vehicles have not been 

extensively investigated experimentally. Nevertheless, some parallels can be drawn from 

experimental studies on the hydrodynamic interactions between surface ships, deducing that 

the interaction effects will depend on the: relative size between the submerged vessels, lateral 

separation distance, longitudinal relative positions, vessel speeds, hull shapes, submerged 

depths, and water depth (Taylor 1909; Newman 1960; Remrey 1974; Kyulevcheliev & 

Varyani. 2004; Kribel 2005, Lataire et al. 2012). 

 

This paper presents the hydrodynamic interaction effects on an AUV operating in close 

proximity to a larger moving submarine, obtained through CFD modelling to quantify the 

surge force, sway force, and yaw moment acting on the AUV at different lateral and 

longitudinal positions relative to the submarine. In order to examine the influence of relative 

size between the two vessels, three AUV models were used giving diameter ratios (i.e. 

submarine diameter to AUV diameter, DExplorer/DSUBOFF in Figure 6.1) of 2.239, 5.723, and 

14.634, with the latter closely representing a typical AUV and a conventional submarine. 

Experimental Fluid Dynamics (EFD) involving captive-model tests of the two vehicles at a 

diameter ratio of 2.239 were carried out to validate and supplement the CFD simulations. The 

results assisted in identifying the adverse interaction regions around the submarine and a safe 

path for the AUV to approach and depart the former. In addition, the resulting map of 

interaction forces and moments is intended to be used in a dynamic manoeuvring simulation 

to evaluate the motion behaviour of the AUV and develop the necessary algorithms to 

maintain the desired trajectory of the vehicle when in operation near a moving submarine. 
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6.2  Investigation Programme 

 

The interaction between the two underwater vessels was investigated through CFD and EFD 

work for the diameter ratio of 2.239 and through CFD for the diameter ratios of 5.723 and 

14.634, at different longitudinal and lateral distances over a range of speeds. The smaller 

AUV was represented by the axisymmetric SUBOFF hull form (Groves et al. 1989) 

developed by the Defence Advanced Research Projects Agency (DARPA), while the larger 

body representing the submarine was based on the International Submarine Engineer Ltd. 

designed Explorer vehicle (ISE 2005).  

 

Figure 6.2 shows the two geometries, with the principal dimensions, relative longitudinal 

distance, and relative lateral distance defined. The length to diameter ratios of the SUBOFF 

and Explorer are 8.575 and 7.243 respectively. The relative lateral distance xdistance and 

relative longitudinal distance ydistance are measured from the centre of buoyancy CB of the 

larger vessel to that of the smaller vessel. For xdistance a ‘positive’ distance signifies that the 

SUBOFF is located in front of the CB of the larger vessel. For the remainder of this paper, the 

longitudinal and lateral distances are referred to as non-dimensionalised ratios RLong and RLat, 

i.e., 

 

 

(6.1) 

 

 

(6.2) 

 

 

Figure 6.2: Definition of the model parameters. 
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The influence of relative size on the interactions was examined as function of diameter ratio 

through CFD. The three diameter ratios of 2.239, 5.723 and 14.634 were achieved by scaling 

the SUBOFF to a diameter of 3.484m, 1.363m and 0.533m respectively, while maintaining 

the diameter of the Explorer at 7.8m. The variables investigated included the length-based 

coefficients of the drag force, sway force, and the yaw moment acting on the SUBOFF 

geometry, with the latter calculated at a reference point located at 0.462LSUBOFF aft of the 

SUBOFF geometry nose tip. 

 

Table 6.1: Vessel dimensions and test parameters. 

Diameter Ratio Parameter SUBOFF Explorer  

Full-scale     

(-3.00 ≤ RLong ≤ 3.00, 0.21 ≤ RLat ≤ 2.45) 

2.239 Length, L 29.875 56.795 [m] 

 Diameter, D 3.484 7.800 [m] 

 Displacement, ∇ 2.255×10
2
 2.309×10

3
 [m

3
] 

 Forward speed, U 7.75×10
-2

, 0.75, 1.50, 3.00 7.75×10
-2

, 0.75, 1.50, 3.00 [m s
-1

] 

 Reynolds Number, Re 2.61×10
6
, 2.51×10

7
, 

5.02×10
7
, 1.00×10

8
 

4.93×10
6
,
 
4.75×10

7
,  

9.49×10
7
, 1.90×10

8
 

[-] 

     

5.723 Length, L 11.685 56.795 [m] 

 Diameter, D 1.363 7.800 [m] 

 Displacement, ∇ 1.350×10
1
 2.309×10

3
 [m

3
] 

 Forward speed, U 1.50 1.50 [m s
-1

] 

 Reynolds Number, Re 1.96×10
7
 9.49×10

7
 [-] 

     

14.634 Length, L 4.570 56.795 [m] 

 Diameter, D 0.533 7.800 [m] 

 Displacement, ∇ 8.075×10
-1

 2.309×10
3
 [m

3
] 

 Forward speed, U 1.50 1.50 [m s
-1

] 

 Reynolds Number, Re 7.68×10
6
 9.49×10

7
 [-] 

     

Model Scale     

(-0.62 ≤ RLong ≤ 0.92, 0.21 ≤ RLat ≤ 0.29) 

2.239 Length, L 1.552 2.935 [m] 

 Diameter, D 0.181 0.405 [m] 

 Displacement, ∇ 3.162×10
-2

 3.237×10
-1

 [m
3
] 

 Forward speed, U 0.75, 1.50 0.75, 1.50 [m s
-1

] 

 Reynolds Number, Re 1.30×10
6
, 2.61×10

6
 2.47×10

6
, 4.93×10

6
 [-] 
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In order to supplement and establish the credibility of the CFD predictions, a series of 

captive-model experiments was carried out for the diameter ratio of 2.239. Since the larger 

vessel had a more dominant pressure field in the interaction compared to the smaller vessel, 

the length of the Explorer was used as the characteristic length scale for dynamic similarity 

between the model scale and full-scale parameters. Table 6.1 summarises the test parameters 

and vehicle model dimensions. 

 

6.3  Simulation Setup 

 

The simulations were performed with ANSYS CFX, a commercial CFD code. The Reynolds 

Averaged Navier-Stokes (RANS) -based Baseline Reynolds Stress Model (BSLRSM) was 

utilised in this analysis using a steady-state approach to the solutions. Previous CFD and EFD 

work by the authors on underwater vehicles of similar geometry to the SUBOFF (Leong et al. 

2014a), showed that the BSLRSM was more accurate in predicting the forces and moments 

acting on vehicles. This was due to its more comprehensive modelling of rotational flow, 

flow separation, and flows that are strongly anisotropic in comparison to RANS-based eddy-

viscosity models.  

 

Figure 6.3 shows the computational fluid domain in a fixed frame of reference, with its centre 

of origin located at the centre of buoyancy of the Explorer (CBExplorer). The far field 

boundaries were kept six body lengths away from the CBExplorer, with the exception of the 

outlet which was kept eight body lengths away, to ensure that boundaries had no blockage 

effect on flow around the vehicles and the wake of the vehicles were sufficiently resolved 

within the domain. The flow at the inlet was prescribed to match the desired vehicle speed 

while the outlet was set as an opening with zero relative pressure. The surfaces of the 

vehicles were prescribed as no-slip walls, while the remaining boundaries were set as free-

slip walls. 

 

The fluid domain was divided into three parts: two subdomains for each of the regions around 

the Explorer and SUBOFF, and an outer domain for the remaining region. The division of the 

domain allowed each part to be meshed and refined individually. This also allowed for easier 

changes in location and configuration for each vehicle without remeshing the entire domain. 

To ensure continuity throughout the domain, the separate parts were connected together using 
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the General Grid Interface (GGI) functionality in ANSYS CFX utilising similar mesh sizes at 

the interface surfaces. 

 

 

Figure 6.3: Computation fluid domain. 

 

For the discretisation of the fluid domain, an unstructured mesh approach was used, i.e. 

triangular prismatic inflation layers around the SUBOFF to capture the boundary layer and 

unstructured tetrahedrons in the far field. An unstructured mesh approach was selected due to 

its ability to easily accommodate mesh deformation and automatic remeshing, features that 

will be required when future simulations of multiple vehicles in relative motion are carried 

out. A well thought out unstructured mesh, although requiring a higher mesh density, offers 

the same degree of accuracy in comparison to a structured mesh (Duda 2011). 

 

6.4  Experimental Work 

 

For the interaction test programme, the experimental data was based on previous work carried 

out by the authors (Leong et al. 2013), which were conducted in the Australian Maritime 

College (AMC) Towing Tank. The 100 × 3.5 × 1.5 m
3
 tank is equipped with a manned 

variable speed carriage and a wave generator, and uses a Horizontal Planar Motion 

Mechanism (HPMM) capable of generating horizontal motion on an underwater vehicle 

model, and recording the resulting forces and moments. 

 

The SUBOFF model was mounted to the HPMM using a ‘sting’ arrangement that connects to 

the model through the aft end, with the forces acting on the SUBOFF model recorded using 

two 6-Degree of Freedom (6-DOF) load cells located inside the model as shown in Figure 
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6.5. The Explorer model was mounted directly onto the carriage by means of a rigid beam 

construction as shown in Figure 6.4, with no forces recorded, as the objective of the work 

was to investigate the behaviour of the smaller vehicle due to the interaction. The RLat 

between the two models was adjusted by shifting the lateral position of the SUBOFF using 

the HPMM, while the RLong was adjusted by shifting the longitudinal position of the Explorer 

along the support beam. Both models were fully flooded and located mid-depth of the tank. 

 

 

Figure 6.4: Experimental testing rig. 

 

 

Figure 6.5: SUBOFF support rig. 
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The experiments were conducted under steady-state conditions, i.e. the vehicles were moved 

together at constant speed. The estimated uncertainty for the measured force and moment 

coefficients were 2.252×10
-4

 and 1.446×10
-4

 respectively, based on the recommended 

analysis procedure outlined in ITTC (2002). 

 

The experiments were only carried out for the 2.239 diameter ratio due to limitations on the 

size of the models in relation to the dimensions of the towing tank. The SUBOFF model had 

to be sufficiently large to accommodate the load balance, while both captive models had to be 

sufficiently small to fit within the towing tank to provide meaningful data without causing 

excessive blockage effects. Although the 2.239 diameter ratio reduced the dominance of the 

larger vehicle on the flow and pressure regime and the resulting behaviour of the smaller 

SUBOFF model, it was reasoned that good agreement between experimental and CFD results 

at the 2.239 diameter ratio provided sufficient validation for the CFD model to be extended to 

the full-scale cases investigated. 

 

6.5  CFD Verification and Validation 

 

6.5.1 CFD Verification and Validation 

 

In order to establish the mesh requirements for the simulations, the effects of the mesh 

resolution on the predicted interaction forces and moments acting on the SUBOFF model 

were examined. 

 

An initial mesh model was created based on the following criteria: the surface area of the 

mesh model of the vehicles was within 0.1% of the geometry model with a maximum domain 

mesh body size equivalent to the diameter of the Explorer. The non-dimensional distance (y
+
) 

of the first inflation layer around the SUBOFF and Explorer for the various simulation runs 

was maintained below one in order to adequately resolve the viscous layer and accurately 

predict the forces and moments on the vehicles using the BSLRSM simulation (Leong et al. 

2014a). The total thickness of the inflation layers around the vehicles was matched to two 

times Prandtl’s theoretical estimate of turbulent boundary layer thickness over a flat plate, i.e. 

2×0.16LS/    

1/7
 (White 2011), where LS is the surface length of the vehicle. Under-

prescribing the total thickness below 1.5 times the theoretical estimate results in higher 

longitudinal force predictions and lower lateral force predictions compared to the 
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recommended thickness. Over-prescribing the total thickness has no noticeable effect on the 

predictions (Leong et al. 2014a). The surface mesh size on the SUBOFF and Explorer was 

selected as the refinement variable for the mesh independence study. The following discusses 

the mesh independence study conducted at a speed of ReExplorer = 9.545×10
7
, with the 

SUBOFF fixed at RLong and RLat of 0.00 and 0.21 respectively.  

 

 

Figure 6.6: Percentage difference of the longitudinal force coefficient X’, lateral force 

coefficient Y’, and yawing moment coefficient N’ predictions from the finest mesh solution 

versus number of mesh elements for the model scale and full-scale diameter ratios 

investigated. 

 

Figure 6.6 shows the percentage difference of the predicted longitudinal force, lateral force, 

and yawing moment for the finest mesh solution as a function of the mesh element density for 

the diameter ratios investigated. For the 2.239 diameter ratios, it is seen that at 3.9 million 

elements and above, the forces and moment predictions for both the model scale and full-

scale were within 2% of the finest mesh investigated (hereafter referred to as ‘mesh 

independence’). The mesh independence of the moment predictions occurred at higher mesh 

densities compared to the forces predictions. The similar mesh independence requirement 

between the two scales indicates that that the mesh model settings can be scaled based on Re 

for the current study. At the higher diameter ratios, the mesh independence of the forces and 

moments occurred around 4.3 million elements for the 5.723 diameter ratio and 4.9 million 

elements for the 14.634 diameter ratio. The increase in mesh density requirement for mesh 

independence as the diameter ratio increases is due to the decrease in the displacement of the 

SUBOFF. As a conservative measure the 4.9, 5.4 and 6.0 million elements mesh model 

configurations were used to represent the 2.239, 5.723 and 14.634 diameter ratio simulations 
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respectively, as they were well within 1% of the forces and moment predictions of the finest 

mesh investigated and provided good flow visualisation to assist with the interpretation of the 

results. 

 

6.5.2 Validation against Experimental Data 

 

In order to assist with validation of the CFD results against the experimental data, the 

computational fluid domain was given the same dimensions as the AMC towing tank except 

for the domain length, which was reduced from 100m to 40m in order to reduce the 

computational requirement while ensuring that the pressure and wake fields generated by the 

vehicles were well resolved within the domain. The free surface of the water, and the 

experimental rig used to support the vehicles were modelled (Figure 6.7) in order to account 

for their effects on the interaction forces and moments acting on the SUBOFF. 

 

 

Figure 6.7: CFD model of the experimental setup with the free surface and support rigs 

modelled (top) and mesh model (bottom). 
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The validation was conducted at the RLat of 0.21 and RLong between -0.62 and 0.92. The 

limited range of the RLong positions investigated was due to limitations in the available test 

area on the carriage and the towing tank. Figures 6.8, 6.9, and 6.10 show the CFD predicted 

longitudinal force, lateral force, and yawing moment respectively acting on the SUBOFF at 

different RLong in comparison with the experimental measurements. The figures show good 

agreement between the CFD and experimental results throughout the RLong range, with the 

difference being less than the experimental uncertainty, i.e. 2.252×10
-4

 for the force 

coefficients and 1.446×10
-4

 for the moment coefficients. The figures also show the CFD 

model scale and full-scale predictions with no blockage and free surface effects on the flow 

around the vehicles. The latter was achieved by extending the domain boundaries six LExplorer 

away from the CBExplorer, with the exception of the outlet which was kept eight body lengths 

away. The model scale predictions with the boundaries extended indicated a substantial 

blockage effect in the EFD results. Thus, the extended domain was used for the remainder of 

the study. The close agreement between the model scale and full-scale predictions with the 

extended boundaries showed that Re scaling based on the LExplorer was appropriate for 

dynamic similarity between the two scales, thus providing sufficient validation for the CFD 

model to be extended to the full-scale cases investigated. 

 

 

Figure 6.8: CFD and experimental results of the longitudinal force coefficient (X’) on the 

SUBOFF vs longitudinal separation ratio (RLong) for a diameter ratio of 2.239 at ReExplorer = 

2.466×10
6
 and RLat = 0.21. 
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Figure 6.9: CFD and experimental results of the lateral force coefficient (Y’) on the SUBOFF 

vs longitudinal separation ratio (RLong) for a diameter ratio of 2.239 at ReExplorer = 2.466×10
6
 

and RLat = 0.21. 

 

 

Figure 6.10: CFD and experimental results of the yawing moment coefficient (N’) on the 

SUBOFF vs longitudinal separation ratio (RLong) for a diameter ratio of 2.239 at ReExplorer = 

2.466×10
6
 and RLat = 0.21. 

 

6.6  Results and Discussion 

 

6.1 Forward Speed  

 

Figures 6.11, 6.12, and 6.13 give the longitudinal force coefficient, lateral force coefficient, 

and yawing moment coefficient respectively on the SUBOFF for the full-scale diameter ratio 

of 2.239 at different RLong and forward speeds, and at a constant RLat of 0.21. The lateral force 

and yawing moment coefficients with respect to RLong were similar for the forward speeds 
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investigated. However, the longitudinal force coefficient (X’) increased as the forward speed 

increased. Further examination revealed that the change in longitudinal force coefficient due 

to the influence of the interaction effects was independent of the forward speed (see Figure 

6.14). The interaction effect was obtained by subtracting the longitudinal force coefficient of 

the SUBOFF alone at RLong = -3.0 (X’Ref) from X’, i.e. X’Ref - X’. These findings suggest that 

the influence of the interaction on the longitudinal force, lateral force, and yawing moment 

coefficients is independent of Re. Therefore, for the remainder on the study, test cases at one 

Re speed is used to investigate the interaction behaviour of the three coefficients. The 

behaviour of the interaction is hereafter represented as X’ - X’Ref,  

Y’ - Y’Ref, and N’ - N’Ref for the longitudinal force, lateral force, and yawing moment 

coefficients respectively in order to focus on the influence of the interaction. 

 

 

Figure 6.11: Longitudinal force coefficient X’ of the SUBOFF vs longitudinal separation ratio 

RLong for the full-scale 2.239 diameter ratio at RLat = 0.21. 

 

 

Figure 6.12: Lateral force coefficient Y’ of the SUBOFF vs longitudinal separation ratio RLong 

for the full-scale 2.239 diameter ratio at RLat = 0.21. 
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Figure 6.13: Yawing moment coefficient N’ of the SUBOFF vs longitudinal separation ratio 

RLong for the full-scale 2.239 diameter ratio at RLat = 0.21. 

 

 

Figure 6.14: Interaction influence on the longitudinal force coefficient X’ – X’Ref of the 

SUBOFF vs longitudinal separation ratio RLong for the full-scale 2.239 diameter ratio at RLat = 

0.21. 
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interaction on the longitudinal force coefficient, lateral force coefficient, and yawing moment 

coefficient respectively acting on the SUBOFF with respect to different RLong and full-scale 

diameter ratios at the forward speed of ReExplorer = 9.49×10
7
, and RLat of 0.21. The figures 

show that the peaks and troughs of the interaction influence on the force and moment 

coefficients decrease as the diameter ratio increases. This is due to the exposure of the 

SUBOFF to the pressure field of the Explorer decreasing as the SUBOFF becomes relatively 

smaller. However, the decrease in the interaction influence on the yawing moment coefficient 
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of the SUBOFF with respect to the increase in diameter ratio was much less than that for the 

longitudinal and lateral force coefficients. The yawing moment coefficient is produced by the 

difference between the clockwise moment and anticlockwise moment about the CBSUBOFF, 

and thus can remain similar between the three different diameter ratios (see Figure 6.18). This 

therefore indicates that a change in diameter ratio does not necessarily reduce the 

susceptibility of the SUBOFF to the adverse effects of the interaction since the 

manoeuvrability of an AUV is adversely affected by both the external forces and moments 

acting on it. 

 

 

Figure 6.15: Interaction influence on the longitudinal force coefficient (X’ – X’Ref) vs 

longitudinal separation ratio RLong for the full-scale diameter ratios of 2.239, 5.723, 14.634 at 

ReExplorer = 9.49×10
7
 and

 
RLat = 0.21. 

 

 

Figure 6.16: Interaction influence on the lateral force coefficient (Y’ – Y’Ref) vs longitudinal 

separation ratio RLong for the full-scale diameter ratios of 2.239, 5.723, 14.634 at ReExplorer = 

9.49×10
7
 and

 
RLat = 0.21. 
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Figure 6.17: Interaction influence on the yawing moment coefficient (N’ – N’Ref) vs 

longitudinal separation ratio RLong for the full-scale diameter ratios of 2.239, 5.723, 14.634 at 

ReExplorer = 9.49×10
7
 and

 
RLat = 0.21. 

 

 

Figure 6.18: Pressure coefficient contours of the flow around the SUBOFF and Explorer 

models at ReExplorer = 9.49×10
7
 and

 
RLat = 0.21 for the diameter ratios of 2.239 on the left and 

14.634 on the right. The pressure coefficient contour range is clipped at ±4.458×10
-2

. 

 

Figures 6.15 and 6.17 show that while the increase in diameter ratio reduces the interaction 

influence of the Explorer on the longitudinal force and yawing moment coefficient of the 

SUBOFF, the trends of the two coefficients remain relatively similar between the diameter 

ratios. The trend of the lateral force coefficient however, differs between the RLong of -0.4 and 

0.4 (see Figure 6.16), whereby a noticeable attraction of the SUBOFF to the Explorer is 

present when the former is around amidships of the latter, i.e. RLong = 0.0. The attraction 

region around the RLong = 0.0 is shown to diminish when the diameter ratio increases to 

14.634. This behaviour is due to the constriction of the flow between the two vessels at the 

lower diameter ratios, thus increasing the magnitude and size of the negative pressure field 

between them (see Figure 6.18).  
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6.3 Relative Longitudinal Position 

 

Given the large quantity of data representing the interaction effects on the force and moment 

coefficients of the AUV for different diameter ratios, the following discussion focuses on the 

data for the diameter ratio of 14.634 as it represents the relative size between a typical 

conventional submarine and an AUV. In Figure 6.18 it is seen that the interaction effects on 

the force and moment coefficients of the SUBOFF are due to the pressure differences 

generated by the Explorer. They change from positive pressure fields around the Explorer’s 

stern and bow tips, to the negative pressure field along the length of the Explorer, which 

intensifies around where the curved sections of the bow and stern meet with the parallel 

midsection of the Explorer. 

 

Figures 6.19, 6.20, and 6.21 give the interaction influence on the longitudinal force, lateral 

force, and yaw moment coefficients respectively of the SUBOFF with respect to different 

RLong for the full-scale diameter ratio of 14.634 at the forward speed of ReExplorer = 9.49×10
7
, 

ReSUBOFF = 7.68×10
6
, and RLat = 0.21.  

 

The longitudinal force interaction influence in Figure 6.19 begins at around RLong of -1.3, 

when the bow of the SUBOFF enters the positive pressure field aft of the Explorer resulting 

in a slight increase in the drag coefficient (see Figure 6.22). At around RLong of -0.6, the 

SUBOFF’s bow progresses into the negative pressure field around the stern region of the 

Explorer, while the SUBOFF’s stern remains in the relatively higher pressure field thus 

significantly reducing its drag coefficient (see Figure 6.19). This reduction peaks at around 

RLong of -0.45, which then declines and recovers to the base value at around RLong of -0.3. 

Between the RLong of -0.3 and 0.2, the negative pressure field along the Explorer is relatively 

uniform longitudinally and thus the interaction has a minimal effect on SUBOFF drag. 

However, as the SUBOFF’s bow progresses into the positive pressure field around the bow of 

the Explorer (RLong = 0.2), the stern of the SUBOFF is yet within the negative pressure 

region, resulting in a significantly increase in drag. This peaks at around RLong of 0.4 and then 

decreases as the whole of the SUBOFF body moves into the forward positive pressure field 

of the Explorer. The drag further decreases as the bow of the SUBOFF passes through the 

positive pressure field and returns to the base value as the SUBOFF’s stern clears the positive 

pressure field around RLong of 1.8.  
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From Figure 6.20 it is seen that at around RLong of -1.0, the SUBOFF starts to experience an 

attraction force towards the Explorer that increases as the SUBOFF progresses forward due to 

the relatively lower pressure region between the two vehicles. This attraction force peaks at 

around RLong of -0.4, and then declines as the SUBOFF moves away from the concentrated 

negative pressure field located around where the curved section of the Explorer stern meets 

with the parallel midsection. At RLong between 0.0 and 0.2, the attraction force acting on the 

SUBOFF is relatively small compared to the attraction force when operating around the stern 

the Explorer. At RLong of 0.2 onwards, the SUBOFF begins to be repelled away from the 

Explorer as its bow progresses into the positive pressure field just forward of the Explorer. 

The repulsion force peaks at around RLong of 0.6, which then declines and diminishes at 

around RLat of 1.1 as the SUBOFF clears away from the pressure field of the Explorer. 

 

In Figure 6.21 it is noted that at around RLong of -1.0, the SUBOFF starts to experience a 

moment that tends to yaw its bow towards the Explorer. The moment increases as the 

SUBOFF progresses into the negative pressure field at the stern of the Explorer and peaks at 

around RLong of -0.4. The moment then decreases as negative pressure field around the 

Explorer becomes uniform, and becomes zero for a small region around RLong of 0.0. Beyond 

this point, the moment acts to yaw the SUBOFF bow away from the Explorer and peaks at 

around RLong of 0.4. The moment then decreases to a negligible magnitude around RLong of 

1.25, as the SUBOFF moves further forward of the Explorer. 

 

 

Figure 6.19: Interaction influence on the longitudinal force coefficient (X’ – X’Ref) vs 

longitudinal separation ratio RLong for the full-scale diameter ratios of 14.634 at ReExplorer = 

9.49×10
7
, ReSUBOFF = 7.68×10

6
 and

 
RLat = 0.21. 
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Figure 6.20: Interaction influence on the lateral force coefficient (Y’ – Y’Ref) vs longitudinal 

separation ratio RLong for the full-scale diameter ratios of 14.634 at ReExplorer = 9.49×10
7
, 

ReSUBOFF = 7.68×10
6
 and

 
RLat = 0.21. 

 

 

Figure 6.21: Interaction influence on the yawing moment coefficient (N’ – N’Ref) vs 

longitudinal separation ratio RLong for the full-scale diameter ratios of 14.634 at ReExplorer = 

9.49×10
7
, ReSUBOFF = 7.68×10

6
 and

 
RLat = 0.21. 
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the larger moving submarine from the stern of the latter. The pressure field around the stern 

region of the submarine increases the risk of collision as the interaction forces and moments 

tend to displace the AUV towards the submarine. The AUV may also encounter difficulty in 

approaching from the bow of the submarine as the interaction forces and moments tend to 

repel the AUV away from the submarine in that region.  
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It was also observed that the interaction forces and moments peak at round RLong of -0.5 and 

0.5, with a high gradient of change in the regions adjacent to the peaks. This suggests that the 

AUV control system will need to have a high rate of response in this region to maintain a safe 

trajectory. The interaction forces and moments were also found to be minimal around 

amidships of the submarine (i.e. RLong = 0.0). However, the SUBOFF needs to travel only a 

small distance adjacent to this region for the direction of yawing moment to change. Thus 

control systems that are too sensitive may cause undesirable oscillations, as they attempt to 

overcompensate for the changes. 

 

6.4 Relative Lateral Position 

 

Figures 6.23, 6.24, and 6.25 give the interaction influence on the longitudinal force, lateral 

force, and yawing moment coefficients respectively acting on the SUBOFF with respect to R-

Long for the full-scale diameter ratio of 14.634 at different RLat, and at the forward speed of 

ReExplorer = 9.49×10
7
 and ReSUBOFF = 7.68×10

6
. The interaction force and moment coefficients 

were found to be minimal at RLat of 0.63 onwards suggesting that the SUBOFF will be 

relatively independent of the interaction influence when passing the Explorer at an RLat above 

0.63. Below an RLat of 0.42, the interaction force and moment coefficients increase at a 

significant rate as the RLat decreases (see Figure 6.26). Thus, a quick response of the SUBOFF 

control system and adequate contribution from its control planes will be required as the 

vehicle approaches the Explorer with a lateral distance (RLat) of less than 0.63. The 

interaction forces and moments coefficients were found to be minimal around amidships of 

the Explorer at the different RLat examined. This suggests that the path of minimal interaction 

for the AUV to approach (see Figure 6.27) or depart the submarine would be laterally around 

the amidships of the latter. 
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Figure 6.22: Pressure coefficient contour of the flow around the SUBOFF and Explorer at 

ReExplorer = 9.49×10
7
 and

 
RLat = 0.21 at different RLong for a diameter ratio of 2.239. The 

pressure coefficient contour range is clipped at ±4.458×10
-2

. 
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Figure 6.23: Interaction influence on the longitudinal force coefficient (X’ – X’Ref) vs 

longitudinal separation ratio RLong at different RLat for the full-scale diameter ratio of 14.634 

at ReExplorer = 9.49×10
7
 and ReSUBOFF = 7.68×10

6
. 

 

 

Figure 6.24: Interaction influence on the lateral force coefficient (Y’ – Y’Ref) vs longitudinal 

separation ratio RLong at different RLat for the full-scale diameter ratio of 14.634 at ReExplorer = 

9.49×10
7
 and ReSUBOFF = 7.68×10

6
. 

 

 

Figure 6.25: Interaction influence on the lateral force coefficient (Y’ – Y’Ref) vs longitudinal 

separation ratio RLong at different RLat for the full-scale diameter ratio of 14.634 at ReExplorer = 

9.49×10
7
 and ReSUBOFF = 7.68×10

6
. 
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Figure 6.26: Interaction influence on the longitudinal force coefficient (X’ – X’Ref), lateral 

force coefficient (Y’ – Y’Ref), and yawing moment coefficient (N’ - N’Ref) vs lateral separation 

ratio RLat for the full-scale diameter ratio of 14.634 at RLong = -0.45, ReExplorer = 9.49×10
7
 and 

ReSUBOFF = 7.68×10
6
. 

 

 

Figure 6.27: Relative path for the SUBOFF AUV to approach the Explorer submarine, where 

the hydrodynamic interaction is minimal. 

 

6.7  Conclusion 

 

In this study, steady-state CFD analysis was carried to understand and quantify the 

hydrodynamic interaction effects on an AUV (represented by the SUBOFF geometry) 

operating in proximity to a larger moving submarine (represented by the Explorer geometry). 

This included investigating the influence of the hydrodynamic interaction on the longitudinal 

force, lateral force, and yaw moment acting on the AUV, with respect to the relative lateral 

and longitudinal positions of the AUV, forward speed, and the relative size between the two 

vehicles. The CFD models were validated against measurements from model scale 

experiments conducted at the AMC Towing Tank. 
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The results showed that the interaction influence on the longitudinal force, lateral force, and 

yawing moment coefficients of the AUV was independent of Re. This suggests that future 

investigations at one operational Re would be sufficient to represent the interaction behaviour 

of the forces and moments acting on the AUV at different positions relative to the submarine. 

However, it will be of interest in future investigations to establish whether and how the 

relative speed between the two vehicles influences the behaviour of the interaction. 

 

The influence of interaction was present between the relative longitudinal distance ratios 

(RLong) of -1.3 and 1.8, and lateral distance ratios (RLat) below 0.64. The interaction forces and 

moments peaked around RLong of -0.4 and 0.4, with the gradient steeply increasing and 

decreasing with respect to RLong adjacent to these peaks. These regions will be a challenge to 

the AUV’s control systems due to the high variation in the interaction forces and moments 

with respect a small change in relative position. It is important to note that these values will 

change due to the shape and size of the larger vessel, as it changes the characteristic of the 

pressure field it generates. Thus, it is important to obtain the interaction influence for 

different vessels. Nevertheless, it is expected that the observed trend in the behaviour of the 

interaction to be relatively similar between torpedo-shaped vessels. 

 

The area around the stern of the submarine was identified as a high collision risk region for 

an AUV travelling through it, as the interaction forces and moments tend to attract the AUV 

towards the submarine. Similarly, the bow region of the submarine is difficult for an AUV to 

approach as the interaction forces and moments act to repel the AUV away from the 

submarine. These interaction effects were found to be minimal around amidships of the 

submarine (RLong = 0), suggesting a safe path for the AUV to approach or depart the 

submarine laterally within that region. 
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Abstract 

 

When an Autonomous Underwater Vehicle (AUV) is operating close to a moving submarine, 

the hydrodynamic interaction between the two vehicles can prevent the AUV from 

maintaining its desired trajectory. This can lead to mission failure and, in extreme cases, 

collision with the submarine. This paper outlines the transient interaction influence on the 

hydrodynamic coefficients of an AUV operating in close proximity and in relative motion to 

a larger moving submarine. The effects of relative motion on the interaction behaviour were 

investigated via two manoeuvres, i.e. the AUV overtaking and being overtaken by the 

submarine at different relative forward velocities and lateral distances. The results presented 

are from a series of Computational Fluid Dynamics (CFD) simulations on axisymmetric 

AUV and submarine hull forms, with validation of the CFD model carried out through scaled 

captive model experiments. The results showed that an AUV becomes less susceptible to the 

interaction influence when overtaking at speeds higher than the submarine. The implications 

of the interaction influence on the AUV’s ability to safely manoeuvre around the submarine 

are also discussed. 
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7.1  Introduction 

 

Over the last decade there have been increasing efforts by navies around the world to extend 

the interoperation capabilities of their submarines with Autonomous Underwater Vehicles 

(AUVs). This direction in development is driven by the ability of AUVs to operate in 

hazardous environments for long periods of time with no real-time user intervention, thus 

mitigating any potential risk away from personnel and high value assets such as submarines 

and surface ships. These factors are most advantageous for reconnaissance and mine hunting 

missions. However, for submarine applications such missions often necessitate the AUV and 

submarine to operate in close proximity in order to launch, recover, and recharge the AUV, in 

addition to the ability to communicate data between them during operations (Hardy & Barlow 

2008; Rodgers et al. 2008; DARPA 2013). This paper focuses on the interaction effects 

acting an AUV operating close to a moving submarine.   

 

 

Figure 7.1: An AUV moving in the wake of a submarine. 

 

When an AUV is operating in close proximity to a moving submarine (Figure 7.1), the AUV 

can experience undesirable changes in its hydrodynamic coefficients due to its interaction 

with the submarine’s wake and pressure fields. These changes can prevent the AUV from 

maintaining its desired trajectory, which can lead to mission failure and, in extreme cases, 

collision with the submarine, resulting in damage or destruction of the AUV and possible 

damage to the submarine appendages or sensors (Bryne 1998). Since AUVs are generally 

much smaller in size relative to submarines, they would be the principle vehicle adversely 

affected by the interaction. Thus, designers need to have a good understanding of the 
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hydrodynamic interaction between the two vehicles in order to develop adequate and robust 

AUV control systems to ensure vehicle stability and identify operating parameters in which 

an AUV can effectively and safely manoeuvre near a moving submarine. 

 

For underwater data communication between an AUV and a submarine, acoustic modems can 

transfer data up to a few kilobits per second over distances well exceeding one thousand 

meters (Gallimore et al. 2010). Optical modems (i.e. lasers) offer much higher transfer rates 

of up to a few megabits per second over distances up to a few hundred meters, depending on 

the turbidity of the water (Scholz 2011). However, due to the restriction on a submarine to 

remain covert throughout missions, data transfer with AUVs tends to be carried out at shorter 

distances or ideally after the recovery of the AUV in order to reduce the probability of 

detection by third parties. Furthermore, the power source of the AUV is likely to need 

recharging before progressing to the next mission. This has led to a growing interest in the 

submarine recovering the AUV for both data transfer and power recharge, thus requiring the 

AUV to safely negotiate the hydrodynamic interaction effects as it approaches the submarine.   

 

Unlike the recovery of an AUV at the surface, underwater recovery via a submarine presents 

several unique challenges. Both vehicles rely on their propeller and the hydrodynamic 

contribution of their control planes for manoeuvring and positioning, thus their hydrodynamic 

control will reduce as the vehicles reduce speed. Furthermore, unless they have additional 

side thrusters along their body, they have limited ability to adjust their transverse positions. 

These factors dictate that the AUV must be recovered while the submarine is moving, with 

the aid of a mechanism to capture the AUV when it is close enough to the submarine hull in 

order to overcome the transverse positioning limitations. Further considerations in favour of 

recovering an AUV via a capture mechanism from a moving submarine are discussed in 

detail by Irani et al. (2014) and Watt et al. (2011).  

 

While several studies have focused on recovery options for AUVs via a submarine (Watt et 

al. 2011; Currie et al. 2014; Hardy & Barlow 2008; Irani et al. 2014), studies characterising 

the effects of the hydrodynamic interaction between submerged vessels remain scarce in the 

public domain. Using steady-state Computational Fluid Dynamics (CFD) simulations, Fedor 

(2009) investigated the hydrodynamic interaction effects on an AUV near a moving 

submarine with the aim of establishing a feasible region in which to launch and recover the 

AUV around the submarine sail. It was found that in the forward region of the sail the 
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interaction acts to repel the AUV from the submarine, with the repelling force increasing as 

the AUV gets closer to the submarine. General trends of the forces and moments acting on 

the AUV were less observable in the regions to the side and astern of the sail due to 

disturbances from the horseshoe vortices generated by the sail. The results suggest that it is 

desirable for recovery to be carried out forward of the sail.  

 

Bryne (1998) developed a real-time manoeuvring simulator to evaluate and demonstrate the 

manoeuvring and control performance of the Phoenix AUV undertaking a docking operation 

via the torpedo tube of a moving submarine. The hydrodynamic interaction between the two 

vehicles was modelled by introducing a parabolic flow velocity profile along the submarine 

hull in order to represent the reduced flow velocity encountered by the AUV as it approached 

the boundary layer of the submarine. However, this is an over-simplification of the 

interaction effects, since it did not account for operational issues associated with the more 

dominant potential field effects generated by a submarine that can either repel or attract the 

AUV depending on their relative positions.  

 

The studies by Bryne (1998) and Fedor (2009) offered an insight into the interaction effects 

acting on an AUV operating within the proximity of a larger moving underwater vessel. 

However, their investigations focused on locations very close to the submarine, thus the 

parameters surrounding the broader extent of the interaction effects and the means for the 

AUV to approach the regions were not discussed.  

 

The authors have previous published results from CFD and experimental work showing that 

the behaviour of the interaction depends on the relative size, longitudinal position, and lateral 

position between the AUV and the submarine (Leong et al. 2014b). The interaction was 

found to attract and repel the AUV at the stern and bow regions of the submarine 

respectively. The magnitude of these attraction and repulsion effects varied greatly with only 

a small change in the relative longitudinal position, suggesting the need for an accurate and 

fast response control system for the AUV to adequately maintain its trajectory around the 

moving submarine. However, these adverse interaction effects were found to be minimal 

around amidships of the submarine, suggesting a safe path for the AUV to approach or depart 

the submarine laterally within that region. However, the results are from steady-state 

numerical and experimental work, i.e. the vehicles are travelling forward at the same speed at 
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different fixed relative positions. Therefore, the effects of relative speed between the two 

vehicles on the interaction effects remain to be established. 

 

This study aims to complement the above work by examining the dynamic effects of the 

interaction acting on an AUV operating in close proximity and in relative motion to a larger 

moving submarine. The work was carried out using CFD modelling to quantify the surge 

force, sway force, and yaw moment acting on the AUV at different speeds, longitudinal 

positions, and lateral positions relative to the submarine in order to identify the behaviour of 

the AUV operating in the interaction zone. The CFD predictions were validated and 

supplemented through experimental captive-model tests. The resulting simulation model is 

intended to be coupled with a control system in a dynamic manoeuvring simulation to 

evaluate the motion behaviour of the AUV and develop the necessary algorithms to maintain 

the desired trajectory of the vehicle when in operation near a moving submarine. 

 

7.2  Investigation Programme 

 

The effects of relative motion on the interaction effects were investigated using two 

manoeuvres, i.e. the AUV overtaking the submarine and being overtaken by the submarine at 

different constant relative lateral distances and velocities (Figure 7.2). The variables 

investigated included the length-based coefficients of the drag force, sway force, and the yaw 

moment acting on the AUV, with the latter calculated at a reference point located at the 

centre of buoyancy of the vehicle. Table 7.1 summarises the investigation parameters and 

vehicle dimensions. 

 

 

Figure 7.2: (a) AUV overtaking manoeuvre, (b) and submarine overtaking manoeuvre. 

 



 

Chapter 7 Page 141 
 

The smaller AUV was represented by the axisymmetric SUBOFF hull form (Groves et al. 

1989) developed by the Defence Advanced Research Projects Agency (DARPA), while the 

larger body representing the submarine was a modified geometry based on the International 

Submarine Engineer Ltd. designed Explorer (ISE 2005). Figure 7.3 shows the two vehicle 

geometries, with definitions for the principal dimensions, relative longitudinal distance, and 

relative lateral distance. A diameter ratio (i.e. DExplorer/DSUBOFF) of 14.634 between the two 

vehicles was used for the relative motion study as it represents the relative size between a 

typical AUV and a conventional submarine. 

 

 

Figure 7.3: Definition of the model parameters. 

 

Table 7.1: Vehicle dimensions and investigation parameters. 

Parameter SUBOFF Explorer  

Length, L 4.570 56.495 [m] 

Diameter, D 0.533 7.800 [m] 

Displacement, ∇ 8.075×10
-1

 2.309×10
3
 [m

3
] 

Base forward speed, U0 1.50 1.50 [m s
-1

] 

Longitudinal distance ratio, 

RLong 

-2.00 to 2.00 

 

[-] 

Lateral distance ratio, RLong 0.15, 0.21, 0.32, 0.43, 0.71, 1.00 [-] 

Relative forward speed ratio, RU 1.00*, 1.33, 1.67, 2.00, 2.33, 2.67 [-] 

*indicates a steady-state approach to the solution 

 

The relative lateral distance xdistance and relative longitudinal distance ydistance were measured 

from the centre of buoyancy CB of the larger vehicle to that of the smaller vehicle. For xdistance 

a ‘positive’ distance signifies that the SUBOFF is located in front of the CB of the larger 

vehicles. For the remainder of this paper, the longitudinal and lateral distances, and the 
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relative forward and lateral speeds are referred to as non-dimensionalised ratios RLong, RLat, 

and RU i.e., 

      
         

         
                                                                  

 

     
         

         
                                                                  

 

   
     

  
                                                                   

 

7.3 Simulation Setup 

 

The simulations were performed using ANSYS CFX, a commercial CFD code. The Reynolds 

Averaged Navier-Stokes (RANS)-based Baseline Reynolds Stress Model (BSLRSM) was 

utilised in this analysis. Previous CFD and Experimental Fluid Dynamics (EFD) work by the 

authors have established that the BSLRSM was more accurate in predicting the forces and 

moments acting on underwater vessels of similar geometry to the SUBOFF, compared to the 

RANS-based eddy-viscosity models within CFX (Leong at al. 2014b). This is due to the 

BSLRSM’s more comprehensive modelling of rotational flow, flow separation, and flows 

that are strongly anisotropic.  

 

The ANSYS Meshing Platform (AMP) remeshing method was used to simulate the relative 

motion between the two bodies. The essential characteristic of this method is that the mesh in 

the fluid domain deforms locally around the object as it moves, and re-meshes when the mesh 

quality is deemed compromised in terms of accuracy and stability. This overcomes the 

limited motions imposed by using a pure mesh deformation approach, and allows adequate 

modelling of the boundary layer and rotation of the bodies compared to other dynamic mesh 

methods within CFX, as discussed by the authors in Leong et al. (2012). 

 

Figure 7.4 shows the computational fluid domain in a fixed frame of reference, with its centre 

of origin located at the centre of buoyancy of the Explorer (CBExplorer). The far field 

boundaries were kept six body lengths away from the CBExplorer, with the exception of the 

outlet, which was kept eight body lengths away. This ensured that boundaries had no 
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blockage effect on flow around the vehicle geometries, and that the wake due to each vehicle 

was sufficiently resolved within the domain. The flow at the inlet was prescribed to match the 

desired vehicle speed, while the outlet was set as an opening with zero relative pressure. The 

surfaces of the vehicles were prescribed as no-slip walls, while the remaining boundaries 

were set as free-slip walls. 

 

 

Figure 7.4: Computational fluid domain. 

 

The fluid domain was divided into three parts: two subdomains for each of the regions around 

the Explorer and SUBOFF, and an outer domain for the remaining region. The division of the 

domain allowed the mesh of the vehicle sub-domains to be kept rigid during the solver 

process, while the outer domain underwent mesh deformation and remeshing, thus 

maintaining mesh quality around the vehicles and reducing the remeshing time. For the 

discretisation of the fluid domain, an unstructured mesh approach was used, i.e. triangular 

prismatic inflation layers around the SUBOFF to capture the boundary layer and unstructured 

tetrahedrons in the far field. The unstructured mesh approach was selected due to its ability to 

easily accommodate the mesh deformation and remeshing. The unstructured mesh approach, 

although it requires a higher mesh density, has also been proven to offer the same degree of 

accuracy in comparison to a structured mesh (Duda 2011). 

 

7.4 Experimental Work 

 

In order to supplement and establish the credibility of the CFD predictions, a series of 

captive-model experiments were conducted in the Australian Maritime College (AMC) 

Towing Tank. The experiments involved two testing regimes: transient measurements of the 
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SUBOFF undergoing pure sway motions, i.e. yasin(2πf), adjacent to the Explorer while 

maintaining a constant RLong (Figure 7.5), and steady-state measurements of the SUBOFF 

fixed at different RLong to the Explorer while maintaining a constant RLat (i.e. ya = 0). For both 

manoeuvres, the two vehicles were travelling at the same constant forward speed. 

The experimental parameters of the manoeuvres are outlined in Table 7.2.  

 

 

Figure 7.5: SUBOFF undergoing a pure sway manoeuvre at a constant RLong to the Explorer.  

 

Table 7.2: Experimental parameters. 

Parameter SUBOFF Explorer Unit 

Length, L 1.552 2.935 [m] 

Diameter, D 0.181 0.405 [m] 

Displacement, ∇ 3.162×10
-2

 3.237×10
-1

 [m
3
] 

Overtaking manoeuvre (steady-state) 

Longitudinal distance ratio, RLong -0.62 to 0.92 - [-] 

Lateral distance ratio, RLat 0.21 - [-] 

Base forward speed, U0 1.50 1.50 [-] 

Reynolds Number, Re 2.61×10
6
 4.93×10

6
 [-] 

Pure sway manoeuvre (transient) 

Longitudinal distance ratio, RLong 0.23 - [-] 

Lateral distance ratio, RLat 0.21 - [-] 

Base forward speed, U0 1.20 1.20 [m s
-1

] 

Reynolds Number, Re 2.09×10
6
 3.95×10

6
 [-] 

Sway oscillation frequency, f 0.2 - [Hz] 

Sway amplitude, ya 0.14 - [m] 
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7.4.1 Experimental Setup 

  

The 100m×3.5m×1.5m tank is equipped with a manned variable speed carriage and a wave 

generator, and uses a Horizontal Planar Motion Mechanism (HPMM) capable of generating 

horizontal motion on the underwater vehicle model, and recording the resulting forces and 

moments. The SUBOFF model was mounted to the HPMM using a ‘sting’ arrangement that 

connects to the model through the aft end, with the forces acting on the SUBOFF model 

recorded via two 6-Degree of Freedom (6-DOF) load cells located inside the model as shown 

in Figure 7.6. The Explorer model was mounted directly onto the carriage by means of rigid 

supports as shown in Figure 7.7, with no forces recorded, as the objective of the work was to 

investigate the behaviour of the smaller vehicle due to the interaction. 

 

The RLat between the two models was adjusted by shifting the lateral position of the SUBOFF 

using the HPMM, while the RLong was adjusted by shifting the longitudinal position of the 

Explorer along the support beam. Both models were fully flooded and located at mid-depth of 

the tank. 

 

 

 

Figure 7.6: SUBOFF support rig.  
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Figure 7.7: Experimental testing rig. 

 

7.5 CFD Verification and Validation 

 

7.5.1 Mesh Independence Study 

 

In order to establish the mesh requirements for the simulations, the effects of the mesh 

resolution on the predicted interaction forces and moments acting on the SUBOFF model 

were examined. The mesh study was conducted at a speed of ReExplorer = 9.545×10
7
, with the 

SUBOFF fixed at RLong and RLat of 0.00 and 0.21 respectively. The surface mesh size on the 

SUBOFF and Explorer was selected as the refinement variable for the mesh study. 

 

An initial mesh model was created based on the following criteria: a maximum Curvature 

Normal Angle of 9˚ (which creates 10 circumferential divisions along a 90˚ circular arc) in 

order to provide adequate resolution of the vehicles’ curvature and a maximum domain mesh 

body size equivalent to the diameter of the Explorer. The non-dimensional distance (y
+
) of 

the first inflation layer around the SUBOFF and Explorer for the various simulation runs was 

maintained below one in order to adequately resolve the boundary layer and accurately 

predict the off-axis hydrodynamic forces and moments on the vehicles using the BSLRSM 

simulation (Leong at al. 2014b). In order to account for the effects of the vehicle’s curvature 

on the boundary layer thickness, the total thickness of the inflation layers around the vehicles 
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was matched to two times Prandtl’s theoretical estimate of turbulent boundary layer thickness 

over a flat plate, i.e. 2×0.16LS/    

1/7
, where LS is the surface length of the vehicle. The 

authors have found from previous CFD work (Leong et al. 2014a) that underprescribing the 

total thickness of the inflation layers below 1.5 times the theoretical estimate results in higher 

longitudinal force predictions and lower lateral force predictions. Over-prescribing the total 

thickness of the inflation layers has no noticeable effect on the predictions. 

 

Figure 7.8 shows the percentage difference of the predicted longitudinal force, lateral force, 

and yawing moment for the finest mesh solution as a function of mesh element density for the 

diameter ratios investigated. For the 2.239 diameter ratio, it is seen that at 3.9 million 

elements and above, the forces and moment predictions for both the model scale and full-

scale were within 2% of the finest mesh investigated. For the diameter ratio of 14.634, the 

forces and moment predictions were within 2% of the finest mesh investigated at around 4.9 

million elements. The increase in mesh density requirement for mesh independence as the 

diameter ratio increases is due to the decrease in the displacement of the SUBOFF. As a 

conservative measure the 4.9 and 6.0 million elements mesh model configurations were used 

to represent the 2.239 and 14.634 diameter ratio simulations respectively, as they were well 

within 1% of the forces and moment predictions of the finest mesh investigated and thus 

deemed to provide a mesh independent solution. 

 

 
Figure 7.8: Percentage difference of the longitudinal force coefficient X’, lateral force 

coefficient Y’, and yawing moment coefficient N’ predictions against the finest mesh solution 

as a function of number of mesh elements for the model scale and full-scale diameter ratios 

investigated. 
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7.5.2 Validation against Experiments 

 

In order to assist with the validation, the CFD model was made to replicate the experimental 

setup. The free surface of the water and the experimental rig used to support the vehicles 

were included in the simulation  model (Figure 7.9) in order to account for their effects on the 

interaction forces and moments acting on the SUBOFF. The computational fluid domain was 

given the same dimensions as the AMC towing tank except for the domain length, which was 

reduced from 100m to 40m in order to reduce the computational requirement while ensuring 

that the pressure and wake fields generated by the vehicles were well resolved within the 

numerical domain. 

 

To account for the inertia forces associated with the accelerative motions in the pure sway 

manoeuvre, the water entrained within the SUBOFF model was also modelled (Figure 7.10). 

The inertia contribution of the SUBOFF shell and mounting was modelled based on 

Newton’s second law of motion, i.e. F=may, where F is the inertia force, m is the mass 

(7.4kg), and ay is the acceleration of the sway motion 

 

 

Figure 7.9: CFD model of the experimental setup, including the free surface and support rigs. 
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Figure 7.10: Mesh model of the experimental setup with the entrained water within the 

SUBOFF shell modelled to account for its inertia effects. 

 

7.5.2.1 Overtaking Manoeuvre (Steady-State) 

 

Figure 7.11 shows the CFD predicted longitudinal force, lateral force, and yawing moment 

coefficients acting on the SUBOFF at different RLong in comparison with the experimental 

measurements for the diameter ratio of 2.239 at model scale. The figures show good 

agreement between the CFD and experimental results throughout the RLong range, with the 

difference being less than the experimental uncertainty as determined using the recommended 

analysis procedure outlined in ITTC (2002), i.e. 2.252×10
-4

 for the force coefficients and 

1.446×10
-4

 for the moment coefficients.  

 

Figure 7.11 also shows the CFD model scale and full-scale predictions with and without 

towing blockage and free surface effects on the flow around the vehicles. The latter was 

achieved by extending the domain boundaries six LExplorer away from the CBExplorer, with the 

exception of the outlet which was kept eight body lengths away. The model scale predictions 

with the extended boundaries indicated substantial blockage effect in the EFD measurements, 

particularly in the longitudinal force coefficient when the SUBOFF was located at the stern 

region of the Explorer, i.e. RLong<0.00. Thus, the extended domain was used for the remainder 

of the study, with the reduced domain used only for validation purposes. The model scale and 

full-scale predictions with the extended boundaries were found to be in close agreement, 

demonstrating that the Re scaling based on the LExplorer was appropriate for maintaining 

dynamic similarity between the two scales and thus providing sufficient validation for the 

CFD model to be extended to the full-scale cases investigated. 
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Figure 7.11: CFD and experimental results of the longitudinal force coefficient X’ (top), 

lateral force coefficient Y’ (middle), and yawing moment coefficient N’ (bottom) on the 

SUBOFF as a function of longitudinal separation ratio RLong for the diameter ratio of 2.239 at 

ReSUBOFF = 2.61×10
6
, ReExplorer = 4.93×10

6
, and RLat = 1.70. The error bars indicate the 

experimental uncertainty, i.e. 2.252×10
-4

 for the force coefficients and 1.446×10
-4

 for the 

moment coefficients. 

 

7.5.2.2  Pure Sway Manoeuvre 

 

Figure 7.12 shows the CFD predicted longitudinal and lateral force coefficients acting on the 

SUBOFF as a function of time in comparison with the experimental measurements for the 
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pure sway manoeuvre test case obtained using the HPMM. The figure shows good agreement 

between the CFD and experimental results, with the differences well within the experimental 

force and moment coefficient uncertainty, and time and phase differences of less than 0.1s 

and 8˚ respectively. The time step used for the CFD simulation was 0.02s as the phase and 

magnitude of the predictions were found to be well within a 1% error margin of the 

predictions using a time step of 0.005s.  

 

 

 

Figure 7.12: CFD and experimental time traces of the longitudinal force coefficient X’ and 

lateral force coefficient Y’ on the SUBOFF for the 0.2Hz pure sway manoeuvre; ReSUBOFF = 

2.09×10
6
, ReExplorer = 3.95×10

6
, and diameter ratio = 2.239. 

 

7.6 Results and Discussion 

 

The following discussion focuses on the influence of the interaction on the SUBOFF’s 

hydrodynamic coefficients for the following two manoeuvres: SUBOFF overtaking the 

Explorer, and SUBOFF overtaken by the Explorer. The magnitudes of the interaction 

influence were obtained by subtracting the baseline SUBOFF’s hydrodynamic coefficients (at 

RLong = -2.0) from the results for the range of parameters outlined in Table 7.1. The results are 

presented as a function of the relative longitudinal position between the two vehicles. 
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7.6.1 AUV Overtaking Manoeuvre 

 

7.6.1.1 Effect of relative longitudinal position 

 

Figure 7.13 shows the interaction influence on the longitudinal force, lateral force, and 

yawing moment coefficients of the SUBOFF as it overtakes the Explorer at a constant RLat of 

0.21. As the SUBOFF approaches the Explorer, the stern pressure field of the latter acts to 

reduce the SUBOFF’s longitudinal force coefficient, laterally attracts the SUBOFF, and yaws 

the SUBOFF bow towards the Explorer. The influence of these interaction effects increases 

as the SUBOFF progresses forward and peaks at around RLong of -0.4. Thus, the stern region 

of the submarine presents a high risk of collision for an AUV to operate within, for an AUV 

maintaining a straight-line overtaking trajectory with no additional control under the 

influence of the interaction.  In the event of collision it is possible for the AUV to lose 

forward speed and be drawn into the submarine’s propeller. The combination of these adverse 

effects and implications makes it undesirable for an AUV to approach the submarine from the 

stern. 

 

As the SUBOFF progresses onwards from RLong of -0.4, the interaction influence declines and 

recovers to the base value at around RLong of 0.0. At RLong of 0.2 onwards, the forward 

pressure field of the Explorer acts to increase the SUBOFF’s longitudinal force coefficient, 

laterally repel the SUBOFF, and yaw the SUBOFF bow away from the Explorer. The 

influence of these interaction effects peaks at around RLong of 0.4, and then declines and 

diminishes at around RLong of 1.5 as the SUBOFF clears away from the pressure field of the 

Explorer. The trends suggest that an AUV will encounter difficultly in approaching the bow 

of the submarine as the influence of the interaction acts to repel the AUV as it passes within 

that region. The interaction influence was found to be minimal around the amidships of the 

submarine, where its negative pressure field is fairly uniform (see Figure 7.14), thus 

suggesting a safe region for the AUV to manoeuvre within. 
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Figure 7.13: Interaction influence on the SUBOFF’s longitudinal force coefficient 

(X’Interaction), lateral force coefficient (Y’Interaction), and yawing moment coefficients (N’Interaction) 

vs relative longitudinal position (RLong) for the AUV overtaking the submarine at different 

relative speeds. 
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Figure 7.14: Pressure coefficient (CP) contours of the flow around the SUBOFF and Explorer 

models at RLong = 0.00 (top) and RLong = 0.25 (bottom); RLat = 0.15. The pressure coefficient 

contour range is clipped at ±0.06. 

 

7.6.1.2 Effect of relative speed 

 

Five overtaking velocities were evaluated and compared with the steady-state results at a 

constant RLat of 0.21 (see Figure 7.13). The magnitude of the interaction influence reduces as 

the SUBOFF overtakes at higher relative velocities to the Explorer. This is due to an increase 

in the SUBOFF pressure field intensity at higher overtaking speeds, thus reducing the 

pressure difference between the SUBOFF and the Explorer. This suggests that an AUV 

becomes less susceptible to the interaction influence when overtaking at speeds higher than 

the submarine. The general trends of interaction influence with respect to RLong at the 

different overtaking speeds were similar to the findings discussed in Section 6.1(a). 

 

Since an AUV relies on its control planes and propeller for trajectory control, the 

hydrodynamic coefficients of the fully appended SUBOFF (see Roddy 1990) is used as an 
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indication of the ability of an AUV to effectively manoeuvre under the influence of the 

interaction. The following discussion is based on the SUBOFF’s yawing moment coefficient, 

as this determines the tendency of the vehicle to adjust its angle of attack given known 

control forces.  The resultant change in angle of attack then acts to generate the directional 

thrust and lateral forces required to effectively manoeuvre. 

 

From Figure 7.13, the interaction influence on the SUBOFF yawing moment coefficients in 

positive and negative directions were found to be at their highest when the SUBOFF 

maintains its position (UR = 0 m/s) at RLat of -0.4 and 0.4; i.e. N’Interaction of -3.3 x 10
-4

 and 3.7 

x 10
-4

 respectively. Based on the SUBOFF’s hydrodynamic coefficients measured by Roddy 

(1990), the N’Interaction values are within the maximum yawing moment contribution of the 

SUBOFF stern rudders (which is approximately 7.0 x 10
-4

 at the maximum rudder angle of 15 

degrees). However, the manoeuvrability of the SUBOFF will be extremely limited at these 

points considering that the maximum angle of attack that can be maintain by the SUBOFF is 

2 degrees bow towards and away from the Explorer at RLat of -0.4 and 0.4 respectively. 

Above these thresholds, the SUBOFF bow will be increasingly yawed towards the Explorer 

at the RLat of -0.4 and in the opposite direction at the RLat of 0.4 due to the combination of the 

interaction influence and the hydrodynamic contribution of the SUBOFF barehull. This 

suggests that it is unlikely for an AUV to safely negotiate the interaction effects around the 

stern and bow regions of a moving submarine, especially in the case of a recovery operation 

within these regions. 

 

7.6.1.3 Effect of lateral distance 

 

Figure 7.15 gives the interaction influence on the longitudinal force, lateral force, and yawing 

moment coefficients of the SUBOFF as it overtakes the Explorer at different RLat. The 

forward speeds of the SUBOFF and Explorer are 3.0 m/s and 1.5 m/s respectively (i.e. U0 = 

1.5 m/s, Ur = 1.5 m/s).  
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Figure 7.15: Interaction influence on the SUBOFF’s longitudinal force coefficient 

(X’Interaction), lateral force coefficient (Y’Interaction), and yawing moment coefficients (N’Interaction) 

vs relative longitudinal position (RLong) for the AUV overtaking the submarine at different 

RLat. The forward speeds of the SUBOFF and Explorer are 3.0 m/s and 1.5 m/s respectively 

(i.e. U0 = 1.5 m/s, Ur = 1.5 m/s). 
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of the interaction influence on the SUBOFF’s longitudinal force coefficients become more 

prominent between the RLong of -0.3 and 0.3, as the RLat reduced from 0.21 to 0.15 (which is 

approximately 8.0m and 4.5m away from the Explorer hull, respectively). Figure 7.14 shows 

that the positive and negative pressure fields of the Explorer propagating from the stern and 

bow, thus the pressure gradient in which the SUBOFF manoeuvres is much greater 

longitudinally at RLat of 0.15 alongside the Explorer. Therefore, it is desirable that the 

recovery operation of an AUV via a capture mechanism to be designed with these changes in 

mind, either by extending the capture mechanism outside the region adversely affected by the 

longitudinal force changes, or an AUV control system that is capable of responding 

sufficiently quickly to the changes in its longitudinal force coefficient in order to maintain its 

relative position. 

 

Further examination of Figure 7.15 revealed that the increase in the interaction influence on 

the SUBOFF’s lateral force and yawing moment coefficients as RLat is decreased can be 

idealised by empirical equations obtained through power regression analysis of the data (see 

Figure 7.16). However, the general trend of interaction influence on the SUBOFF’s drag 

coefficient as a function of both RLat and RLong (as discussed earlier) was less observable, thus 

necessitating that the evaluation of close proximity manoeuvres of such vehicles be carried 

out through virtual, experimental, or real world testing rather than through empirical models 

in order to realistically represent the nature of such operations.  

 

 

Figure 7.16: Power regression analysis of the interaction influence on the SUBOFF’s 

longitudinal force coefficient (X’Interaction), lateral force coefficient (Y’Interaction), and yawing 

moment coefficients (N’Interaction) as a function of RLat for the AUV overtaking the submarine 

at the RLong of 0.4. The forward speeds of the SUBOFF and Explorer are 3.0 m/s and 1.5 m/s 

respectively (i.e. U0 = 1.5 m/s, Ur = 1.5 m/s). 
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7.6.2 Submarine Overtaking Manoeuvre 

 

7.6.2.1 Effect of relative longitudinal position 

 

Figure 7.17 shows the interaction influence on the longitudinal force, lateral force, and 

yawing moment coefficients of the SUBOFF as it overtaken by the Explorer at a constant RLat 

of 0.21.  

 

 

 

 

Figure 7.17: Interaction influence on the SUBOFF’s longitudinal force coefficient 

(X’Interaction), lateral force coefficient (Y’Interaction), and yawing moment coefficients (N’Interaction) 

vs relative longitudinal position (RLong) for the submarine overtaking the AUV at different 

relative speeds. 
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to increase the SUBOFF drag. This is due the negative pressure field around the bow region 

of the Explorer progressing onto the SUBOFF’s stern, while the bow of the latter remains in 

the positive pressure field. The increase in drag peaks at around RLong of 0.4, and then 

declines and recovers to the base value at around RLong of 0.3. Between the RLong 0.3 and 0.0, 

the SUBOFF experiences a drag reduction due its stern moving into a relatively higher 

pressure field. At RLong of 0.0, the Explorer pressure field in which the SUBOFF resides is 

relatively uniform longitudinally and thus the interaction has a minimal effect on the 

SUBOFF drag. As the Explorer progresses forward, the SUBOFF experiences an increase in 

drag up to RLong of -0.3, from which point onwards the interaction influence acts to reduce the 

SUBOFF drag. The drag reduction reaches its maximum value at around RLong of 0.4 and then 

declines. At RLong of -0.6 onwards the SUBOFF begins to experience an increase in drag 

which gradually recovers to the base value at an RLong of -1.3 as the Explorer’s pressure field 

clears away from the SUBOFF. 

 

With regards to the interaction influence on the lateral coefficient, the Explorer acts to repel 

the SUBOFF as it approaches at around RLong of 1.3. The repulsion increases to its maximum 

value at around RLong of 0.6, before steeply declining to the base value at around RLong of 0.5. 

Between RLong of 0.5 and -0.5, the interaction acts to attract the SUBOFF. Two prominent 

troughs of the attraction occur at 0.3 and -0.3. As the Explorer progresses from RLong of 0.4, 

the interaction acts to repel the SUBOFF from the Explorer, increasing to its maximum value 

at around RLong of -0.6 and then declines to a negligible magnitude at around RLong of 1.3. 

 

The trend of the interaction influence on the SUBOFF’s yawing moment coefficient was 

found to be similar to that for the AUV overtaking the submarine (see Section 6.1), with the 

Explorer acting to yaw the SUBOFF bow away and towards the former at the Explorer bow 

and stern regions respectively. 

 

7.6.2.2 Effect of relative velocity 

 

The interaction influence on the SUBOFF’s hydrodynamic coefficients when overtaken by 

the Explorer at five different relative velocities were evaluated and compared with the steady-

state results at a constant RLat of 0.21 (see Figure 7.17).  
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The magnitude of the interaction influences is shown to increase as the Explorer overtakes at 

higher relative velocities to the SUBOFF. While the general trends of the interaction 

influence were similar to the AUV overtaking the submarine (see Section 6.1), the 

magnitudes of interaction influence for the submarine overtaking the AUV were much more 

pronounced. These magnitudes were much more than the steady-state results and exceeded 

the hydrodynamic contribution of the SUBOFF control planes significantly. This suggests 

that it is unlikely that an AUV will be able to negotiate the interaction influence or maintain 

its trajectory when overtaken by a submarine at close proximity without larger control planes, 

which in turn may create additional interaction issues. 

 

7.7 Conclusion 

 

The paper presents a study conducted to quantify the behaviour of an AUV operating in close 

proximity to a larger moving submarine at different relative velocities. The investigation 

utilised CFD and EFD techniques to quantify the longitudinal force, lateral force, and yawing 

moment coefficients of the AUV with respect to the different relative longitudinal positions 

between the two vehicles in order to characterise the behaviour of the AUV under the 

influence of the interaction.  

 

The EFD results from captive model tests were used to validate the CFD model and showed 

good agreement, thus enabling the latter to be used for further analysis of the interaction 

under full-scale conditions. The effects of relative velocities on the interaction behaviour 

were investigated via two manoeuvres: the AUV overtaking the submarine and vice versa, 

both at a constant relative lateral distance. The effects of lateral distance (RLat) on the 

interaction were also investigated for the AUV overtaking the submarine.  

 

The results showed that an AUV becomes less susceptible to the interaction influence when 

overtaking at speeds higher than the submarine. The general trend of the results showed that 

the submarine’s stern presents a high collision risk region for an AUV to travel within, as the 

interaction forces and moments tend to attract the AUV towards the submarine. Similarly, the 

bow region of the submarine is difficult for an AUV to approach as the interaction forces and 

moments act to repel the AUV away from the submarine. The adverse interaction effects 

were found to be minimal around amidships of the submarine throughout the different 
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relative velocities examined, suggesting a safe path for the AUV to approach or depart the 

submarine laterally around this region. 

 

The interaction influence of the submarine’s bow and stern regions on the AUV’s lateral 

force and yawing moment coefficients were found to vary as a power of RLat, with the two 

coefficients increasing as the RLat decreases. General trends of the effects of RLat on the 

interaction influence on the AUV’s longitudinal force coefficient as a function of RLong were 

less observable. Therefore, it is desirable that the evaluation of manoeuvres involving close 

proximity between an AUV and a submarine to be carried out through virtual, experimental, 

or real world testing of the vehicles rather than through empirical models in order to 

realistically represent the behaviour of the vehicles. 

 

In the case of the submarine overtaking the AUV, the interaction influence on the latter’s 

hydrodynamic coefficients were found to exceed the ability of the AUV’s control planes to 

compensate. Therefore, it is unlikely that the AUV will be able to maintain its trajectory 

when approached by a submarine, without larger control planes on the AUV. The larger 

planes may however cause additional interaction affects. 

 

Further work is being undertaken to extend the current assessment of the interaction 

behaviour for fully appended models of the AUV and the submarine, in order to identify the 

interaction influence of the submarine’s propeller and sail, and the AUV’s appendages. These 

fully appended vehicle models are to be used in a dynamic manoeuvring simulation to 

evaluate the operating parameters in which an AUV can safely approach a submarine for 

recovery, and develop the necessary control algorithms for the AUV to successfully negotiate 

the manoeuvres.  
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Chapter 8 :  

Summary, Conclusions  

and Further Work 

 

This chapter provides an overall summary of the thesis and brings together the findings of the 

individual chapters. It also concludes the findings and outcomes, and discusses the 

implications of the findings, the limitations, and the recommendations for further research.   
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8.1  Summary 

 

The focus of this thesis was to investigate the hydrodynamic interaction effects on an 

unappended Autonomous Underwater Vehicle (AUV) operating in the proximity of a larger 

moving submarine. In this Chapter, an overall evaluation is made of the results and findings, 

and their contributions to the research field. Limitations of the study are also discussed and 

used to provide guidance for future research to increase the understanding of hydrodynamic 

interaction between underwater vehicles and their impact on AUV-submarine inter-

operations. 

 

In addressing the main research question, What are the hydrodynamic interaction effects on 

an AUV manoeuvring in the proximity of a larger moving underwater vehicle?, a review of 

literature was carried out on operations involving underwater vehicles in proximity and under 

the influence of the hydrodynamic interaction between the vehicles. While there are 

investigations linked to technologies and operational considerations for the recovery of an 

AUV by a moving submarine, the effects of the hydrodynamic interaction between the 

vehicles has yet to be extensively investigated. Depending on the relative speed and position 

between the vehicles, the hydrodynamic interaction can cause the AUV to undergo 

uncontrollable motions which can result in mission failure. Thus, it is important to have a 

good understanding of the hydrodynamic interaction between the two vehicles in order to 

develop AUV control systems that can ensure vehicle stability and identify operating 

parameters in which an AUV can effectively manoeuvre near a submarine. 

 

This thesis focuses only on the unappended configuration of the vehicles. This has allowed 

the hydrodynamic interaction between the barehulls of the vehicles to be the focal point of 

the study, thus enabling the investigation of the effects of relative size, position, and velocity 

between the two vehicles on the interaction behaviour to be unadulterated. The AUV and 

submarine are represented by the SUBOFF and Explorer geometries respectively. 

 

As there are limited studies on quantifying and characterising the hydrodynamic interaction 

effects between underwater vehicles in relative motion, an incremental build-up approach to 

the Computational Fluid Dynamics (CFD) capabilities and analysis was undertaken. These 

consisted of the steady-state CFD analysis of a single AUV (Chapter 2), verification of the 
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dynamic meshing methods for CFD modelling of multiple underwater bodies in relative 

motion (Chapter 3), steady-state analysis of the hydrodynamic interaction effects on an AUV 

operating in the proximity of a submarine (Chapter 4, 5 & 6), and finally the transient 

analysis of the hydrodynamic interaction effects on a AUV operating in relative motion and 

in the proximity of a submarine (Chapter 7). The experimental work carried out to validate 

and supplement the CFD results are discussed within the respective chapters. 

 

8.2  Conclusions 

 

As a result of the study described in this thesis, the following main conclusions are drawn: 

 

8.2.1  Behaviour of the Hydrodynamic Interaction 

 

Relative longitudinal position: The submarine’s stern presents a high collision risk 

region for an AUV to travel within, as the interaction forces and moments tend to 

attract the AUV towards the submarine. Similarly, the bow region of the submarine is 

difficult for an AUV to approach as the interaction forces and moments act to repel 

the AUV away from the submarine. The bow and stern regions of the submarine also 

present a challenge to the AUV’s control systems due to the steep change in the 

magnitude of the interaction forces and moments with respect to a small change in 

relative longitudinal position. The adverse interaction effects were found to be 

minimal around amidships of the submarine, suggesting a safer path for the AUV 

would be to approach or depart laterally within that region. These findings are 

consistent throughout the thesis under model-scale conditions (Chapter 4) and full-

scale conditions (Chapters 5, 6 and 7), and for the different diameter and length ratios 

examined within the respective chapters. 

 Relative lateral position: The increase in the interaction influence on the AUV’s 

lateral force and yawing moment coefficients was found to follow a power-law 

relation with the decrease in lateral distance to the submarine. However, a general 

trend in the increase of the interaction influence on the AUV’s drag coefficient as the 

lateral distance to the submarine decreased was less observable. 

 Extent of the submarine interaction influence on the AUV: The interaction 

influence of the submarine on the AUV was found to be unperceivable beyond the 
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relative distance of one submarine length from the submarine’s centre of buoyancy; 

both laterally and longitudinal. 

 Relative size: The interaction influence on the longitudinal and lateral force 

coefficients of the AUV was found to decrease when the size of the submarine was 

increased while maintaining the same lateral distance ratio (i.e. relative lateral 

position/submarine length) and length to diameter ratio of the two vehicles. However, 

the interaction on the yawing moment coefficient remained relatively unchanged thus 

suggesting that change in the size of the submarine does not necessarily reduce the 

susceptibility of the AUV to the adverse effects of the interaction. 

 Relative length: The influence of the hydrodynamic interaction on the AUV as a 

function of the ratio of the relative longitudinal position to the submarine length was 

very similar in both magnitude and trend when the AUV operates in the proximity of 

submarines of different lengths with the same diameter. While a change in the length 

of the submarine does not reduce the interaction influence on the AUV, the interaction 

influence evolves over a larger longitudinal distance with an increase in the submarine 

length and thus allowing more time for the AUV to respond to the change in the 

interaction influence. 

 Relative motion: The speed at which the AUV overtakes the submarine from behind 

was found to have a significant effect on the magnitude of the interaction forces and 

moments experienced by the AUV. As the overtaking speed of the AUV was 

increased the interaction influence reduced. Thus, an AUV becomes less susceptible 

to the interaction influence when overtaking at higher speeds. In the case of the 

submarine overtaking the AUV, the interaction influence on the AUV’s 

hydrodynamic coefficients was found to exceed the ability of the AUV’s control 

planes to compensate. Therefore, it is unlikely that the AUV will be able to maintain 

its trajectory when approached from astern by a submarine. 

 Limits of the AUV to manoeuvre under hydrodynamic interaction: The ability for 

the AUV’s control planes to compensate against the interaction influence at the bow 

and stern regions of the submarine was found to be extremely limited when the AUV 

is maintaining the same speed as the submarine. This suggests that it is unlikely for an 

AUV to safely negotiate the interaction effects around the stern and bow regions of a 

moving submarine, especially in the case of a recovery operation within these regions. 
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8.2.2  CFD, Experiments, and Modelling 

 

 Flow modelling with CFD: CFD has proven to be a reliable and accurate tool to 

capture the hydrodynamic characteristics of underwater vehicles (Chapter 2) and the 

hydrodynamic interaction between them (Chapters 4 to 7), with consistent good 

agreement against experimental measurements. CFD has also shown to be especially 

useful to overcome the restrictions of physical experiments (e.g. full-scale 

investigations, removal of the experimental blockage and mounting strut effects, and 

overcoming motion restrictions such as overtaking manoeuvres), thus allowing a more 

extensive investigation of the problem to be conducted. A greater understanding of 

the hydrodynamic interaction behaviour was also achieved using CFD flow 

visualisation, showing that the pressure field generated by the vehicles is the 

dominant mechanism behind the interaction behaviour. However, given the number of 

variables that can affect the quality of the CFD predictions, it is paramount that the 

CFD predictions are validated through experimental or trial data. It is also desirable 

that CFD and experimental work are carried out in conjunction as CFD was also used 

in this thesis to assist with the design of the experiment. This included predicting the 

hydrodynamic load on the models which defines the required structural support, 

measuring equipment, and limits of the experiment. The CFD predictions also 

provided confidence in the experimental measurements as they are taken.  

 RANS-based turbulence models: Chapter 2 showed that with a sufficiently fine 

mesh, appropriate mesh treatment, and simulation conditions matching the 

experiments, the BSLRSM predictions of the AUV’s hydrodynamic coefficients 

under translation and rotational flow conditions were in good agreement with 

published experimental measurements. Although the SSTCC predictions were 

agreeable with the longitudinal force coefficient, they fall outside the experimental 

uncertainty for both the lateral force and yawing moment coefficients. This suggests 

the need for BSLRSM when cross-flow separation is present on an underwater 

vehicle. The superior ability of the BSLRSM over SSTCC to predict the 

hydrodynamic coefficients of a bluff body in Chapter 2 are also supported by Chapter 

3, showing that the BSLRSM predictions of the drag on a sphere over a wide range of 

Reynolds numbers were consistently closer to published experimental data compared 

to the SSTCC predictions. 
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 Dynamic meshing for bodies in relative motion: Of the two dynamic meshing 

methods evaluated in Chapter 3, i.e. ANSYS Meshing Platform (AMP) Remeshing 

and Immersed Solids Method (ISM), the performance of the AMP Remeshing was 

found to be far superior for modelling bodies undergoing large positional 

displacement compared to the Immersed Solid technique in both accuracy and 

computational effort. The difference in the accuracy performance is due to the 

capability of the AMP Remeshing to resolve the boundary layer around the bodies. 

Although the ISM does not require remeshing or a mesh to resolve the boundary layer 

around each body, it still requires a fine mesh in the fluid domain regions where the 

body travels. This fine mesh increases substantially with the motion range, and as a 

result increases the computational time, whereas the AMP Remeshing allows the 

mesh refinement to be maintained locally around the bodies. 

 Computational Time: The BSLRSM simulations required 20 percent extra 

computational time compared to the equivalent SST model, which was considered 

reasonable in light of the improved results the former provided. The average 

computing resources used to perform the computations were 8 CPU cores, with a total 

RAM of 8GB. Both the cluster and standalone PCs were used, with the former 

primarily employed for steady-state simulations. A standalone PC was used for the 

transient simulations that involved remeshing in order to reduce the computational 

time (up to 50% compared to the cluster). The average time for steady-state 

simulations were 3 to 6 hours while the transient cases took around one week. 

 Experiments: The experimental work (Chapters 4 to 7) has provided valuable data to 

validate the CFD predictions and insight into the characteristics of the hydrodynamic 

interaction between the two vehicles. While the experiments required higher cost and 

preparation compared to simulations, the experiments required shorter run time and 

the physics are fully captured as opposed to the CFD predictions where the physics 

may not have been fundamentally resolved correctly. The co-agreement between CFD 

and experimental results provides the necessary confidence in simulation models, 

which in turn substantially reduces the development time of simulation models. 

 Scaling effects: The investigation of the scaling effects on the hydrodynamic 

interaction presented in Chapter 5 showed that the hydrodynamic coefficients of the 

model scale results are identical to the full-scale results based on Reynolds scaling, 

given that the blockage and mounting strut effects in the experimental setup are 
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accounted for (in this case through CFD). This provided confidence in the CFD 

predictions of the hydrodynamic interaction behaviour under full-scale conditions in 

Chapters 6 and 7.   

 

8.3  Implications of the Research 

 

In this thesis, CFD and experimental work were conducted to investigate the hydrodynamic 

interaction between the unappended configurations of an AUV operating in close proximity 

to a moving submarine. This has allowed the hydrodynamic interaction between the barehulls 

of the vehicles to be the focal point of the study, thus enabling the investigation of the effects 

of relative size, position, and velocity between the two vehicles on the interaction behaviour 

to be unadulterated by the influence of the appendages. The results presented not only help 

designers to develop a deeper insight into the hydrodynamic interaction between underwater 

vehicles but also as a guide to improve the operations involving multiple underwater vehicles 

manoeuvring in close proximity and the design of AUV launch and recovery systems on 

submarines.   

 

There has also been much developmental work done on the methodology and the capabilities 

of the CFD models to investigate the interaction behaviour. The CFD work explored the 

effects of y
+
 in the near-wall mesh, total thickness of the inflation layers, and model boundary 

conditions on the CFD predictions to accurately represent the hydrodynamic characteristics 

of the underwater vehicles. This area has been surprisingly neglected as the majority of CFD 

studies on torpedo-shaped underwater vehicles (such as the SUBOFF geometry) have focused 

on methodologies to validate the CFD predictions with very limited discussion on the 

modelling factors that can affect the predictions.  

 

The CFD work also evaluated the performance of two dynamic meshing methods within 

ANSYS CFX (i.e. AMP Remeshing and ISM) in modelling underwater bodies in relative 

motion.  Although the algorithms behind the methods have undergone substantial 

development in recent years, there are currently no existing studies demonstrating their 

capabilities in modelling multiple bodies in relative motion, let alone their performance in 

terms of accuracy. Furthermore, the AMP Remeshing method is a beta feature in ANSYS 
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CFX that has yet to be fully integrated into the software, and thus guiding principles in 

utilising the method is also discussed (see also Appendix III). 

 

In addition to the innovations in the CFD work, the experimental results are of significant 

value as there are very few experimental-based studies in the public domain characterising 

the behaviour of the interaction between such vehicles. 

 

These efforts have resulted in an increase in data quality, overall confidence in the data, 

reduction in analysis time, and greater understanding of the interaction behaviour that will 

form the basis and support for further work on fully-appended configurations of the 

underwater vehicles.  

 

8.4  Further Work 

 

Direct extension of this thesis could lead to the following.  

 

1. Extend the investigation into the interaction behaviour for fully-appended models of 

the vehicles, enabling comparison against the unappended data in this study in order 

to identify the interaction influence of the submarine’s propeller, sail, and control 

surface, and the AUV’s appendages. The addition of the appendages will make the 

CFD computations more challenging and require greater computational resource. 

While the methodology to develop a CFD model of an appended hull is subjected to 

the same scrutiny as an unappended hull, the former requires the following: 

 mesh and turbulence model sensitivity studies to be carried out independently 

for each of the appendages (e.g. sail and stern control surfaces) and the hull to 

ensure that the model is able to capture their individual hydrodynamic 

characteristics prior to their integration; and 

 mesh and turbulence model sensitivity studies to be carried out for the 

appended hull as they will affect the interaction between the appendages and 

hull, and also the development of the sail wake which affects the performance 

of the stern control surfaces downstream. 

2. Investigate the interaction behaviour of the AUV at different incidence angles in 

proximity to the submarine. 
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3. Investigate the interaction behaviour of the AUV in the proximity of submarines of 

different diameters with the same length. The current results and findings are 

acknowledged as being insufficient to form generalised conclusions about the effects 

of the change in diameter on the interaction behaviour. 

4. Extend the experimental setup for testing of underwater vehicles undergoing 

longitudinal relative motion. This will allow a more extensive validation study of the 

CFD prediction of the overtaking manoeuvres between the vehicles.  

5. Investigate the performance of emerging mesh-free CFD solutions such as Particle-

based method and Finite Pointset method in modelling underwater vehicles in relative 

motion and the hydrodynamic interaction between them. The mesh density required 

for adequate accuracy in the predictions for the test cases investigated in this thesis 

was found to be the main factor in determining the total time of the simulations. Thus, 

mesh-free solutions may reduce the simulation time considerably while offering 

similar accuracy.   

6. Further develop and trial the ANSYS CFX-MATLAB interface presented in 

Appendix III for manoeuvring simulations of multiple vehicles in relative motion.  

 

The long term objective of the work will be a dynamic manoeuvring simulation environment 

that would realistically represent the nature of close proximity operations between 

underwater vehicles. The work in this thesis provides the foundation to reach this objective.  
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Appendix I:  

Uncertainty Analysis of the Experimental Data 

 

The principle values for the uncertainty analysis of the experimental data are presented here. 

The uncertainty analysis was conducted in accordance with the ITTC guidelines (ITTC 

2002), and has been adapted for underwater vehicles.  

 

Model Particulars       

Definition Symbol Value Units 

Length between perpendiculars LPP 1.556 m 

Length on waterline LWL 1.556 m 

Length overall submerged LOS 1.556 m 

Diameter of hull D 0.181 m 

Draft even keel T 0.181 m 

Wetted Surface Area - total S 0.763 m
2
 

Wetted Surface Area - hull SBH 0.763 m
2
 

Wetted Surface Area- appendages SAPP 0.000 m
2
 

Area Waterplane AWP 0.240 m
2
 

Displacement ∇ 0.03185 m
3
 

Block Coefficient CB 0.625 - 

Waterplane Area Coefficient CW 0.852 - 

Wetted Surface Coefficient CS 3.427 - 

    Constant       

Gravity g 9.81 m/s
2
 

Density - reference ρref 998.6 kg/m
3
 

Water Temp - test t 18 deg 

Water Density - test ρ 998.6 kg/m
3
 

Pulse count c 600 - 

Time based circuitry Δt 0.1 s 

Carriage wheel diameter DCWheel 0.555 m 

 

Multiple Run Data Set           

Run No. U (m/s) Rx (g) Rx (N) Cd (Cd-Cdmean)
2
 

1 1.5 346.156 3.396 0.00125 2.71E-12 

2 1.5 334.182 3.278 0.00121 1.73E-09 
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3 1.5 335.185 3.288 0.00121 1.44E-09 

4 1.5 367.278 3.603 0.00133 6.08E-09 

Mean 1.5 345.700 3.391 0.00125   

Standard deviation         5.55E-05 

Single Run Data Set         

Run No. U (m/s) Rx (g) Rx (N) Cd 

1 1.5 346.156 3.396 0.00125 

 

Measurement Accuracy and Bias       

Definition Symbol Accuracy Bias Limit 

Model Geometry       

Model Length BL 1.00E-03 2.00E-03 

Carriage Speed 

Pulse Count BC - 2.36E+00 

Optical Encoder BC1 1.00E+00 1.00E+00 

AD Converter 1 BC2 1.50E+00 1.50E+00 

AD Converter 2 BC3 1.50E+00 1.50E+00 

Voltage to Frequency Converter BC4 2.50E-01 2.50E-01 

Wheel diameter BD 1.00E-03 1.00E-03 

Time Base BΔt 1.03E-05 1.03E-05 

Velocity BU - 5.65E-03 

Tank Water Temperature and Density       

Thermometer reading BT 5.00E-01 5.00E-01 

Temp-density relationship BP1 9.20E-02 9.20E-02 

Convert temp to density BP2 7.00E-02 7.00E-02 

ITTC density assumption BP3 3.00E+00 3.00E+00 

Density BP - 3.00E+00 

Resistance Measurement       

Accuracy of Calibration Weights BRX1 5.00E-05 5.66E-05 

Mass/Voltage relationship SEE BRX2 3.07E-02 3.07E-02 

Load cell misalignment BRX3 2.50E-01 1.08E-05 

AD Converter BRX4 0.00E+00 0.00E+00 

Inclination of model due to speed BRX5 2.50E-01 1.08E-05 

Resistance BRX - 3.07E-02 

Coefficinet of Total Resistance BCT - 4.31E-05 

Partial Derivatives     

Partial Derivative - Resistance Coefficient Symbol Value 

  

𝜕  

𝜕 
 -1.25E-03 
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𝜕  

𝜕 
 -1.67E-03 

  

𝜕  

𝜕𝜌
 

-1.25E-06 

  

𝜕  

𝜕  
 

3.68E-04 

Partial Derivative - Velocity 

  
  

𝜕 

𝜕 
 7.11E-04 

  

𝜕 

𝜕  
 

2.36E+00 

  

𝜕 

𝜕 𝑡
 -4.26E+00 

Partial Derivative - Density 

  

  

  

|
𝜕𝜌

𝜕𝑡
| 

1.83E-01 

   Precision Limit (95% Confidence)     

Precision Limit Symbol Value 

Multiple Sample Precision Limit PCTM 5.55E-05 

Single Sample Precision Limit PCTS 1.11E-04 

 

Total Uncertainty - Resistance Coefficient (95% Confidence)       

Uncertainty Symbol Value  %Cd 

Multiple Sample Total Uncertainty UCTM 7.03E-05 5.63 

Multiple Sample Total Uncertainty UCTS 1.19E-04 9.54 
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Appendix II :  

Setup of the ANSYS Meshing Platform (AMP) 

Remeshing Method for Vehicles in Motion 

 

AII.1 Introduction 

 

This appendix outlines the basic concepts of setting and running a simulation of vehicles in motion 

using the ANSYS Meshing Platform (AMP) Remeshing method in ANSYS CFX. The capability of 

the AMP Remeshing method is demonstrated through two test cases, i.e.: 

 

 simulation of an AUV undergoing a prescribed motion relative to a larger vehicle, and; 

 simulation of an AUV undergoing a motion in response to an external force. 

 

The capability of the AMP Remeshing method is demonstrated through two test cases, i.e.: 

 

 simulation of an AUV undergoing a prescribed motion relative to a larger vehicle, and; 

 

AII.2 Overview of the AMP Remeshing Method 

 

The essential aspect of the AMP Remeshing method is that the mesh in the fluid domain deforms 

locally around the body as it moves, and re-meshes when the mesh quality is deemed poor. The 

simulation information from the previous mesh is interpolated into the new mesh. The re-mesh 

process is summarized in the flowchart given in Figure AII.1.  
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Figure AII.1: Flowchart of the re-mesh method process. 

 

The interrupt conditions, e.g. mesh quality below a predetermined threshold, to initiate remeshing 

script is defined in the solver control. The process of the remeshing script is summarized into five 

main parts: 

 

 Part 1: Opens ANSYS WorkBench (WB) project component. 

 Part 2: Extract monitor data from current the time step. 

 Part 3: Override values of WB parameters for the geometry and mesh based on monitor data. 

 Part 4: Recreate geometry and mesh. 

 Part 5: Replace mesh, interpolate solution on new mesh, continue solver run. 

 

AII.3 Overview of the Physics Models 

 

The following offers an overview of the governing equations for the physic models used in the 

simulation architecture.  

 

AII.3.1 Fluid Dynamics Model 

 

The governing equations for the simulation of the flow fluid are based on an Arbitrary Lagrangian-

Eulerian (ALE) form of the Navier-Stokes equations to accommodate the deformation in the mesh, a 
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feature that is required due to the relative motion between multiple vehicles. The ALE formulation 

allows the mesh motion to be defined independent of the motion of the fluid being analysed. For the 

present CFD analysis, the fluid is assumed isothermic, and hence does not consider the 

thermodynamic equations within the solution algorithm. The conservation equations for mass and 

momentum are as follows where ui and umj represent the velocity field relative to a local coordinate 

system and the boundary movement of the vehicle respectively (ANSYS 2012; and Dajka & Gerber 

2007): 

 

Mass conservation: 
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Momentum: 
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where stable forces on the body Fs is  
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and the apparent body force Fb is  
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An additional set of mesh displacement Laplace equations must be added to solve the ALE 

formulation, and that is the Laplace solutions which diffuse the motion of vehicle’s boundary into the 

interior of the fluid domain. The resulting solution, obtained by integrating over the time interval, 

allows for the extraction of the mesh velocity umj. The set of Laplace equations have the form: 

 

Mesh displacement equations: 

0
 
  
   

i

j j

x

x x



 

where 

0  i i ix x x
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The displacement diffusion coefficient  can be a function of near wall distance, or mesh volume 

size.  

 

AII.3.2 Rigid Body Dynamics Model 

 

The equations of motions to predict the motion response of the vehicle are based on a translating-

rotating coordinate system fixed to the vehicle. The general equations of motion as follows:  

 

Sum of forces: 

 GF mu
 

 

Acceleration of the centre of gravity, 

      G O O G Gxyz
u u u r r   

 

 

Applied moments around about a point O on the body gives, 

        O G G
xyz

M I I r mu  
 

 

where 

    [

   −   −   

−      −   

−   −      

] 

 

The product of inertia, [I] is evaluated at the centre of gravity of the body. 

 

The system of equations to be solved to track the motion of the body based on the axial (x-axis), 

lateral (y-axis), and normal (z-axis) forces are as follows, 

 

     2 2

G G G CFD S Pm u x q r y pq r z pr q X X X         
 

     2 2

G G G CFD S Pm v y r p z qr p x qp r Y Y Y         
 

     2 2

G G G CFD S Pm w z p q x rp q y rq p Z Z Z         
   

 

Similarly, the system of equations based on the rolling (x-axis), pitching (y-axis) and yawing (z-axis) 

moments are, 
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 x zx xy x zx xy G G CFD S PI p I r I q I p I r I q m y w Z v K K K         

 y xy yz y xy yz G G CFD S PI q I p I r I q I p I r m z u x w M M M         

 z yz zx z yz zx G G CFD S PI r I q I p I r I q I p m x v y u N N N         
 

 

This results in a matrix system: 

0 0 0

0 0 0

0 0 0

0

0

0

   
   
   
   
   
   
   
   
      

 

 

 


   

   

  

G G RHS LHS

G G RHS LHS

G G RHS LHS

x xy zxG G RHS LHS

xy y yzG G RHS LHS

RHS LHSzx yz zG G

m mz my X Xu
m mz mx Y Yv

m my mx Z Zw
mZ my I I I K Kp

mz mx I I I M Mq

N Nrmy mx I I I







 
 
 
 

 

 

The solution of the matrix system results in estimates at the new time level of accelerations (

, , , , ,u v w p q r
), which in turn with the time step known allow for calculation of velocities (u, v, w, 

p, q, r). Finally, the auxiliary derivatives in the inertial frame ( , , , , , , , ,O O O O O Ox y z u v w    ) is then 

integrated to obtain the new position and angular movement  

(
, , , , ,O O Ox y z   

). 

 

AII.4 Geometry Creation 

 

AII.4.1  Defining the projectname 

 

First, a projectname is specified for the WorkBench project archive, i.e. projectname.wbpj.  

The projectname becomes the first part of the name for the files the simulation creates and is needed 

as a reference link between the WorkBench module and the ANSYS CFX solver for the remeshing 

option to work. 

 

When defining the projectname, the following points must be followed due to the characteristics of 

the Linux operating system and the MATLAB scripts used in the AMI: 

 The projectname is case-sensitive hence references to it must be identical. 

 The first letter must be alphabetical and not be a numeral digit, special character or space. 

 The projectname must not contain space or special character including ‘_’. 

 

AII.4.2  Workbench Setup 
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The ANSYS Workbench is used to define the geometry and mesh model. For this, the Geometry and 

Mesh module (see Figure AII.2) is used which consists of the DesignModeler and ANSYS Meshing 

Platform (AMP). The Geometry and Mesh module must be the only module existing within the 

Workbench and must be the first module referenced, i.e. ‘A’ for the remeshing option to work. 

 

 

Figure AII.2: Workbench layout with the geometry and mesh module 

 

AII.4.3 Defining the Geometry Model using DesignModeler 

 

Importing Geometry of the Vehicle 

 

Figure AII.3: Vehicles at their respective base plane 

 

Geometry 
& Mesh 
Module 
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An independent plane for each of the vehicle must first be created to allow them to move 

independently of each other during simulation. The geometries of the vehicles are then imported onto 

their respective plane (see Figure AII.3). For the geometries of the vehicles, it recommended that: 

 The geometries are imported as ‘Frozen’. 

 The import functions, ‘clean bodies’ and ‘heal bodies’, are disabled to avoid unexpected 

changes to the geometry, e.g surfaces. Imported geometries should always be checked for 

consistency with the original geometry.  

 The surface of the vehicle geometry should be divided into sub-faces as oppose to a single 

surface. This substantially reduces the meshing time as the  

sub-faces guide the meshing algorithm in resolving the geometry. 

 The STEP (.stp) format is recommended for the imported geometries as the format retains a 

higher degree of information and quality compared to the other formats supported. 

Alternatively, if the geometries were created using DesignModeller, ANSYS’s proprietary 

format, ANSYS Geometry Database (.agdb) offers equal quality. 

 The geometry quality should be as high as possible and also realistic in shape. If needed, 

DesignModeler does have repair tools for geometry and works reasonably well. However, 

they should be avoided and if used, care is advised as they can cause undesired changes to the 

geometry. 

 

Parameterising the Geometry for Remeshing 

The parameterising process consists of these general steps (see Figure AII.4): 

i. Click the box next to the parameterisable variable of the geometry. The box will be 

denoted with the ‘D’ symbol which indicates that parameterisation of the variable is 

enabled. 

ii. In the prompt, specify the parameter name.   

iii. The parameters can then be checked, modified and renamed as necessary within the 

Parameter Manager interface as shown in Figure AII.5.  
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Figure AII.4: Parameterisation of the geometry variables 

 

 

Figure AII.5: Parameter set of the geometry model 

 

Parameterising allows the geometry components to undergo transformation (e.g. translation and 

rotation) during simulation. While parameterising the model, special attention must be given to the 

parameter names where the names of the parameters must be identical to the names of the solver 

monitor data. This creates the necessary reference links between the geometry components and the 

solver as required by the remeshing process. It is noted that:  

 parameter values transferred do not taken into account the units, and  

 the same steps to parameterise the geometry model can be used to parameterise the mesh 

model. 

 

Creating the Fluid Domain 

SUBOFF 
Plane 

Variable for translating the SUBOFF 
along the z-axis 

Parameter name 
for the z-
translation 
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The profile for the fluid domain is created and then extruded as a frozen body (see Figure AII.6). 

Unless the fluid domain size is made to replicate a physical dimension, it is advisable that the fluid 

domain boundaries should be sufficiently far away from the vehicles to: 

 Avoid boundary effects on the fluid and pressure fields of the vehicles. 

 Allow the mesh deformation, due to the vehicle motions, to be absorbed by the larger mesh 

elements away from the vehicle. This substantially reduces the number of remeshing events 

required during simulation. 

 

 

Figure AII.6: Extruded fluid domain 

 

Subdividing the Fluid Domain to Aid the Remeshing Process 

For the stability and efficiency of the remeshing process, it highly recommended that the fluid domain 

be subdivided into the regions around the vehicles and the main fluid domain, especially when 

inflation layers are used around the vehicles. This allows: 

 The mesh within the vehicle subdomains to be rigid, i.e. no deformation occurs, thus 

maintaining the mesh quality around the vehicles and preventing the inflation layers and 

surrounding mesh, which are small in volume, from skewing or collapsing into negative 

volume elements while the vehicles are in motion. 

 The majority of the mesh deformation to be absorbed by the mesh in the main fluid domain. 

Since the larger elements away from the vehicle regions are able to absorb more deformation, 

this allows a higher degree of vehicle motion before mesh quality is compromised, thus 

substantially reducing the number remeshing event for the simulation. 

 

The subdividing process of the fluid domain consists of these general steps: 

i. Create the sketch profile of the subdomain around a vehicle, e.g. a box-shaped domain as 

shown in Figure AII.7. 

ii. Extrude the sketch as Frozen to form a body. 

iii. Subtract the subdomain from fluid domain with Preserve Tool Bodies-Yes. 

iv. Subtract the vehicle from the subdomain with Preserve Tool Bodies-No. 
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For CFD simulations, only the fluid around the vehicles is of interest. The subtract steps above are to 

remove the solid volume of the vehicles from the fluid domain.  

 

 

Figure AII.7: Extruded SUBOFF subdomain 

 

   

 

 

Figure AII.8: Subdivision of the fluid domain for the SUBOFF subdomain 

 

The subdividing domain process for the SUBOFF is repeated for the Explorer. Figure AII.9 shows the 

final geometry model. 

 

Fluid 
Domain 

SUBOFF 
Domain 

Fluid 
Domain 

SUBOFF  
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Figure AII.9: Completed geometry model of the SUBOFF and Explorer 

 

A box is preferred for the subdomain shape over a shape with curvature, e.g. cylinder. With the box 

subdomain, the Advanced Size Function – Proximity to be used without the Curvature option. This 

takes half the remeshing time compared to when Curvature is used. Even though the actual remeshing 

time has been substantially reduced to less than a minute by the option to remesh only the fluid 

domain while leaving the subdomains unchanged during a remeshing event, reducing the remeshing 

time further by half is desired as the total remeshing time is compounded by the number of remeshing 

events in a simulation. 

 

As for the size of the subdomain, its boundaries should be at least a body diameter away from the 

vehicles to allow sufficient inflation layers and mesh elements to reside within the subdomain.  

 

Naming the Geometry Features 

The last step to the geometry model is to define the names for the features of the geometry using the 

named selection option, e.g. the surfaces of the geometry, the boundaries of the fluid domain, and the 

interfaces of the subdomains. Naming the features is optional but it does substantially simplify the 

mesh generation process and simulation setup by allowing the geometry features to be referenced by 

the specified names.   

 

AII.5 Creating the Mesh Model using ANSYS Meshing Platform 

(AMP)  

 

AII.5.1 General 
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In order to reduce the remeshing time and the interpolation error caused by a remeshing event, only 

the main fluid domain is remeshed leaving the mesh inside the subdomains untouched. The general 

process in creating the mesh model consists of creating the mesh of the subdomains independently 

and lastly leaving only the meshing setup of main fluid domain within WorkBench for the remeshing 

event.  

 

Prior to creating the mesh, the following change is recommended in order to speed up the meshing 

process: 

 Open the AMP module and go to Tools>Options>Meshing>Meshing>Number of CPUs> 7, 

if the PC has 8 cores available. 

 

The recommended number of CPUs should be 1 or 2 less than the available cores on a PC. This is to 

allow at least 1 core available for the operating system and background applications in order to 

prevent a bottleneck of performance. The solver needs to sync all partitions for each solution loop 

hence the computational speed limited by the slowest partition; i.e. a partition will take longer to solve 

if it shares a CPU with the operating system and if the combined load on the CPU is close to 100%.   

 

AII.5.2 Creating the Mesh 

 

SUBOFF Subdomain 

i. Suppress the main fluid domain and Explorer subdomain, leaving only the SUBOFF 

subdomain active. 

ii. General mesh settings (unless specified, default used): 

 Solver preference > CFX 

 Advanced Size Function > On: Curvature 

 Smoothing > High (Improves mesh angle quality) 

 Minimum Size > 0.005m (Optimal value for the SUBOFF shape without 

compromising force predictions. Smaller value will increase mesh density 

substantially) 

iii. Specify the face sizing for the SUBOFF surface. One tenth of the vehicle diameter gives 

reasonably good prediction without creating excessive mesh elements. The curvature 

advanced function will automatically refine the mesh around surfaces with high curvature up 

to 18
0
 accuracy of the geometry or up to the min size limit of 0.005m as specified in the 

general mesh settings. 

iv. Specify the inflation prism layers for the SUBOFF surface (e.g. see Figure AII.10): 

 Use total thickness option for more uniform prism layers 
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 Specify total thickness equivalent to the boundary layer (BL) thickness. For a good 

estimate of the thickness, use 0.16(VehicleLength)/ ReLength
1/7

 which is an estimate of 

the thickness for a turbulent BL on a flat plate. The prescribed total thickness should 

never be less the estimated thickness as this will ‘squash’ the predicted boundary 

layer and produce spurious results. 

 For an emphasis on computational speed with reasonable accurate predictions, there 

should be at least 15 layers in the boundary layer and the y
+
 of the first layer 

thickness should be well within the log layer, e.g. around 30. For example, ReLength at 

2.1x10
6
 with a prism growth rate of 1.2 gives a maximum thickness of 0.04m and 15 

prism layers for the SUBOFF. The settings are shown in Figure AII.11. 

v. Specify the face sizing for the surfaces of the subdomain that will interface with the surfaces 

of the fluid domain. The face size for the interface is determined by meshing the subdomain 

with the settings above and measuring the length of the smallest element on the surface. This 

ensures a uniform element face size on the interface. 

vi. Specify the body sizing for the subdomain. The body size is recommended to be same as the 

face size determine in step v. 

vii. Generate mesh. 

viii. Export mesh as SUBOFFDomain.meshdat 

 

 

Figure AII.10: Inflation prism layers settings 

 

Figure AII.11: SUBOFF subdomain mesh 

 

Explorer Subdomain 

i. Clear generated mesh. 
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ii. Suppress the main fluid domain and SUBOFF subdomain, leaving only the Explorer 

subdomain active. 

iii. Create the Explorer mesh using steps ii-vii from the instructions for creating the SUBOFF 

mesh. 

iv. Export mesh as ExplorerDomain.meshdat 

 

 

Figure AII.12: Explorer subdomain mesh 

 

Fluid Domain 

i. Reset only the mesh module under the WorkBench project schematic. 

ii. Suppress the SUBOFF and Explorer subdomain, leaving only the fluid domain active. 

iii. General mesh settings (unless specified, default used): 

 Solver preference > CFX 

 Advanced Size Function > On: Proximity 

 Smoothing > High  

 Proximity accuracy > 0.2 

 Nums Cells Across Gap > 10 

 Proximity Min Size > 0.02 (Same as the face size for the SUBOFF interface)  

 Max face size > 0.5m 

 Max size > 0.5m 

iv. Specify the same face sizing for the surfaces interfacing between the fluid domain and 

SUBOFF subdomain, and the surfaces interfacing between the fluid domain and the Explorer 

domain. 

v. Generate mesh. 

vi. Save changes to project file. 
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Figure AII.13: Fluid Domain mesh 

 

AII.6 Prescribed Motion Test Case 

 

AII.6.1 Geometry 

 

The AUV and larger vehicle are represented by the Explorer and SUBOFF respectively. The 

dimension of the fluid domain is 20m long, 3.55m wide and 1.5m high in order replicate the 

dimensions of the AMC Towing Tank. It is noted the towing tank length of 100m was shortened to 

20m as two vehicles are fixed in the longitudinal direction, whereby their forward motions were 

modelled by prescribed an equivalent flow speed in the opposite direction.  

 

 

 

Figure AII.14:  Mesh model of the SUBOFF and Explorer 

 

AII.6.2 Test Case Condition 
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Figure AII.15:  Initial location of the two vehicles 

 

The global coordinate centre of origin is located at the nosetip of the SUBOFF. The Explorer nosetip 

is initially located 0.725m laterally and 0m longitudinally with respect to the SUBOFF nosetip as 

shown in Figure AII.15. Both vehicles are fully submerged in water with a depth of 0.75m along their 

nosetip and are located 5m aft the Inlet fluid domain boundary. Both vehicles travel forward at a 

speed of 1.2m/s while the SUBOFF undergoes an additional oscillatory transverse motion. A 

summary of the test conditions are given in Table AII.1. 

 

Table AII.1: Prescribed motion test case parameters 

Parameter SUBOFF Explorer 

Initial nosetip coordinate [x, y, z] 0m, 0m, 0.75m 0m, 0.725m, 0.75m 

Forward speed, U0 1.2m/s 1.2m/s 

ReLength 2.10x10
6 

3.96x10
6 

Transverse displacement amplitude, a 0.14m - 

Transverse oscillation frequency, f 0.2Hz - 

Angle of incidence, θ 0° 0° 

Water density, ρ 997 kg/m
3
 

Water dynamic viscosity, μ 8.899x10
-4

 kg/ms 

 

AII.6.3 Test Case Simulation: CFX-Pre Setup 

 

Note: Red font = expression 

 

General 

i. Create the mesh models of the fluid domain and the vehicle subdomains at their initial 

locations following the instructions in Section 3. 

ii. Open CFX-Pre. 

0.725

m 
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iii. Go to Edit>Options> CFX-Pre>General> Auto Generation and disable Automatic 

Default Interfaces 

iv. Create a new General Case and save as “SUBOFFExplorer.cfx” in working directory 

v. Import the subdomain meshs - Right click on Mesh tree > Import Mesh > ANSYS 

Meshing. Change file filter to all files to find the *.meshdat files 

vi. Import the outer domain mesh  from workbench project archive, e.g. [working 

directory]/SUBOFFExplorer_files/dp0/MECH/SYS.mshdb 

vii. Simulation>Flow Analysis 1> Analysis Type>  

 Option> Transient 

 Time Duration> Option> Total Time 

 Total Time > CSimTime  

 Time Steps> 

 Option > Timesteps 

 Timesteps > CSimTimeStep 

 Initial Time> 

 Option > Automatic with Value 

 Time > 0 [s] 

 

Fluid Domain 

i. Rename ‘ Default Domain’ to ‘FluidDomain’ 

ii. FluidDomain > Basic Settings > 

 Location and Type > 

 Location > ….. (Select all three mesh) 

 Domain Type > Fluid Domain 

 Fluid 1 > Option > Material > Water 

 Domain Models > Pressure > Reference Pressure > 1 [atm] 

 Buoyancy Model > Non-Buoyant 

 Domain Motion > Stationary 

 Mesh Deformation> 

 Option > Regions of Motion Specified 

 Mesh Motion Model > Option > Displacement diffusion 

 Mesh stiffness > 

 Option > Increase near Boundaries 
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 Model Exponent > 10 

 

Vehicle Subdomain 

i. Right click on FluidDomain and insert Subdomain 1 for the SUBOFF subdomain 

ii. Subdomain: Subdomain 1 > 

 Basic Settings > Location > [Select SUBOFF subdomain] 

 Mesh Motion > Mesh Motion > 

 Option > Specified Displacement 

 Displacement >  

 Option > Cartesian Components 

 X Component > 0 [m] 

 Y Component > SUBOFFDisplaceY 

 Z Component > 0 [m] 

iii. Right click on FluidDomain and insert Subdomain 2 for the Explorer subdomain 

iv. Subdomain: Subdomain 2 > 

 Basic Settings > Location > [Select Explorer subdomain] 

 Mesh Motion > Mesh Motion > 

 Option > Specified Displacement 

 Displacement > Option > Stationary 

Note: This allows the mesh within the subdomains to be rigid, allowing deformation to occur 

only in the main fluid domain. 

 

Subdomain Interface 

i. Right click on FluidDomain and insert Domain Interface 1 for SUBOFF subdomain. 

Note: This will also create boundaries ‘Domain Interface 1 Side 1’ and ‘Domain 

Interface 1 Side 2’ 

ii. Domain Interface 1> 

 Basic Settings > 

 Interface Type > Fluid Fluid 

 Interface Side 1 

 Domain (Filter) > FluidDomain 

 Region List > SUBOFFInnerInterface 

 Interface Side 2 
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 Domain (Filter) > FluidDomain 

 Region List > SUBOFFOuterInterface 

 Additional Interface Models > 

 Mass and Momentum > Conservative Interface Flux 

 Mesh Connection Method > 

 Mesh Connection > GGI 

iii. Fluid Domain> 

 Domain Interface: Domain Interface 1 Side 1 > Boundary Details > 

 Mesh Motion > 

 Option > Specified Displacement 

 Displacement > 

 Option > Cartesian Components 

 X Component > 0 [m] 

 Y Component > SUBOFFDisplaceY 

 Z Component > 0 [m] 

 Domain Interface: Domain Interface 1 Side 2 > Boundary Details > 

 Mesh Motion > 

 Option > Specified Displacement 

 Displacement > 

 Option > Cartesian Components 

 X Component > 0 [m] 

 Y Component > SUBOFFDisplaceY 

 Z Component > 0 [m] 

iv. Right click on FluidDomain and insert Domain Interface 2 for Explorer subdomain. 

Note: This will also create boundaries ‘Domain Interface 2 Side 1’ and ‘Domain 

Interface 2 Side 2’ 

v. Domain Interface 2> 

 Basic Settings > 

 Interface Type > Fluid Fluid 

 Interface Side 1 

 Domain (Filter) > FluidDomain 

 Region List > ExplorerInnerInterface 
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 Interface Side 2 

 Domain (Filter) > FluidDomain 

 Region List > ExplorerOuterInterface 

 Additional Interface Models > 

 Mass and Momentum > Conservative Interface Flux 

 Mesh Connection Method > 

 Mesh Connection > GGI 

vi. Fluid Domain> 

 Domain Interface: Domain Interface 2 Side 1 > Boundary Details > 

 Mesh Motion > 

 Option > Stationary 

 Domain Interface: Domain Interface 2 Side 2 > Boundary Details > 

 Mesh Motion > 

 Option > Stationary 

 

Domain Boundaries 

i. Inlet: 

i. Right click on Fluid Domain and insert boundary ‘Inlet’ 

ii. Fluid Domain > Boundary: Inlet >  

 Basic Settings > 

 Boundary Type > Inlet 

 Location > Inlet 

 Boundary Details >  

 Mass and Momentum > 

 Option > Cart. Vel. Components 

 U > DomainFlowSpeedU  

 V > 0 [m s^-1] 

 W > 0 [m s^-1] 

 

ii. Outlet: 

i. Right click on Fluid Domain and insert boundary ‘Outlet’ 

ii. Fluid Domain > Boundary: Outlet >  

 Basic Settings > 
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 Boundary Type > Opening 

 Location > Outlet 

 Boundary Details >  

 Mass and Momentum > 

 Option > Opening Pres. And Dirn 

 Relative Pressure > 0 [Pa] 

 

iii. Wall: 

i. Right click on Fluid Domain and insert boundary ‘Wall’ 

ii. Fluid Domain > Boundary: Wall >  

 Basic Settings > 

 Boundary Type > Wall 

 Location > Wall 

 Boundary Details >  

 Mass and Momentum > 

 Option > Free Slip Wall 

 

iv. SUBOFF: 

v. Right click on Fluid Domain and insert boundary ‘SUBOFF’ 

vi. Fluid Domain > Boundary: SUBOFF >  

 Basic Settings > 

 Boundary Type > Wall 

 Location > SUBOFF 

 Boundary Details >  

 Mesh Motion > 

 Option > Specified Displacement 

 Displacement > 

 Option > Cartesian Components 

 X Component > 0 [m] 

 Y Component > SUBOFFDisplaceY 

 Z Component > 0 [m] 

 Mass and Momentum > 

 Option > No Slip Wall 
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vii. Explorer: 

i. Right click on Fluid Domain and insert boundary ‘Explorer’ 

ii. Fluid Domain > Boundary: Explorer >  

 Basic Settings > 

 Boundary Type > Wall 

 Location > Explorer 

 Boundary Details >  

 Mesh Motion > Option > Stationary 

 Mass and Momentum > Option > No Slip Wall 

 

Domain Initialization 

i. FluidDomain > Initialization 

 Domain Initialization > Initial Conditions > 

 Cartesian Velocity Components > 

 Option > Automatic with Value 

 U > DomainInletFlowSpeed 

 V > 0 [m s^-1] 

 W > 0 [m s^-1] 

 Static Pressure > 

 Option > Automatic with Value 

 Relative Pressure > 0 [Pa] 

 

viii. Solver 

i. Solver Control > Basic Settings >  

 Advection Scheme > High Resolution 

 Transient Scheme >  

 Option > Second Order Backward Euler 

 Timestep Initialization > Automatic 

 Turbulence Numerics > Option > First Order 

 Convergence Control > 

 Min. Coeff. Loops > 1 

 Max. Coeff. Loops > 3  
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 Interrupt Control > Interrupt Control Conditions > 

 Insert ‘Interrupt Condition 1’ 

 Interrupt Condition 1 > 

 Option > Logical Expression 

 Logical Expression > MeshOrthoAngle < 10 

ii. Right click on Solver and insert ‘Expert Parameters’ 

 Expert Parameters > Discretisation > meshdisp diffusion scheme > value > 3 

(Note: This improves the diffusion of the mesh deformation thus extending the 

mesh deformation allowed before compromising the mesh quality) 

 Expert Parameters > Convergence Control > Memory Control > 

 Enable ‘topology estimate factor’ 

 Value = 1.2 

(Note: This prevents memory issues as the preallocated memory is fixed 

during simulation) 

iii. Output Control >  

 Trn Results > Transient Results > 

 Insert ‘Transient Results 1’ 

 Transient Results 1 >  

 Output Frequency >  

 Option > None 

 Monitor > Monitor Points and Expressions >  

 Insert the monitor points below. Note that it is essential that the names 

of the monitor points tracking the position of the SUBOFF be identical 

to the names of their respective parameters in WorkBench for the 

remeshing process. 

 Monitor Point Name > SUBOFF_LocX 

 Expression Value >  

ave(Total Centroid Displacement X)@SUBOFF 

 Monitor Point Name > SUBOFF_LocY 

 Expression Value >  

ave(Total Centroid Displacement Y)@SUBOFF 

 Monitor Point Name > SUBOFF_LocZ 

 Expression Value >  
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ave(Total Centroid Displacement Z)@SUBOFF 

 Monitor Point Name > SUBOFF_Fx 

 Expression Value >  

force_x()@SUBOFF 

 Monitor Point Name > SUBOFF_Fy 

 Expression Value >  

force_y()@SUBOFF 

 Monitor Point Name > SUBOFF_Fz 

 Expression Value >  

force_z()@SUBOFF 

 Monitor Point Name > Explorer_Fx 

 Expression Value >  

force_x()@Explorer 

 Monitor Point Name > Explorer_Fy 

 Expression Value >  

force_y()@Explorer 

 Monitor Point Name > Explorer_Fz 

 Expression Value >  

force_z()@Explorer 

 Monitor Point Name > MeshAngleQuality 

 Expression Value >  

MeshOrthoAngle 

 

ix. Expressions 

i. Insert the following expressions: 

 Expression Name > CSimTime 

 Definition > 20 [s] 

 Expression Name > CSimTimeSteps 

 Definition > 0.01 [s] 

 Expression Name > DomainFlowSpeedU 

 Definition > -1.2 [m s^-1] 

 Expression Name > MeshOrthoAngle 

 Definition >  
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180/pi*minVal(Orthogonality Angle Minimum)@REGION:B40 

(Note: B40 is the reference ID of the main FluidDomain mesh. To 

insert, right click on the definition window for the expression, Mesh 

Locator > 3D > [select the FluidDomain ref. ID]. To check if the 

reference ID is correct, extend the Mesh tree. 

 Expression Name > SUBOFFDisplaceY 

 Definition > DesiredSUBOFFDisplaceY - ReinitialSUBOFFDisplaceY 

 Expression Name > DesiredSUBOFFDisplaceY 

 Definition > 0.14[m]*sin(2*pi*0.2*t/1[s]) 

 Expression Name > ReinitialSUBOFFDisplaceY 

 Definition > 0.14[m]*sin(2*pi*0.2*Mesh Initialisation Time/1[s]) 

(Note: The Total Centroid Displacement variable tracks the displacement of 

each boundary’s centroid since the beginning of the analysis (that is, relative 

to the original mesh). The specified displacement based mesh motion is 

relative to the initial mesh and must therefore include an offset to account for 

mesh re-initialization. The Mesh Initialisation Time variable corresponds to 

the time at which mesh re-initialization last occurred. This is essential for 

prescribed motion simulations that utilise the remeshing option.) 

 

x. Execution Control 

i. Right on Simulation Control and insert ‘Execution Control’ 

 Execution Control >  

 Run Definition >  

 Solver Input File > [working directory]/SUBOFFExplorer.def 

 Parallel Environment 

 Run Mode > Platform MPI Local Parallel 

 Number of Processes > 7 

(Note: Select the parallel run mode available on the operating 

system. The number of processes specified should be at least 

one core processer less than the total available processers on 

the computer)  

 Partitioner > 

 Partitioning Detail > 
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 Partitioner Type > Optimised R.C.B. 

 Partitioning Weighting > Automatic 

 Partitioner Memory > 

 Memory Alloc Factor > 1.4 

 Solver > 

 Solver Memory > 

 Memory Alloc Factor > 1.4 

(Note: The Memory Alloc Factor of 1.4 for both the Partitioner prevents the 

‘insufficient memory error’ encountered with the default options) 

xi.  

xii. Remeshing Configuration 

i. Right click on Configuration and insert ‘Configuration 1’ 

 Configuration 1 >  

 General Settings > 

 Insert ‘Activation Condition 1’ 

 Activation Condition 1 > 

 Option > Start of Simulation 

 Remeshing > 

 Under Remesh Definitions, insert ‘Remesh 1’ 

 Remesh 1 > 

 Option > User Defined 

 Activation Condition(s) > Interrupt Condition 1 

 Location > B40 

(Note: Specify the FluidDomain reference ID) 

 External Command >  

/ansys_inc/v140/Framework/bin/Linux64/runwb2 -B –R /[working 

directory]/WB_Remesh.wbjn 

 Replacement File > 

/[working directory]/SUBOFFExplorer_files/dp0/MECH/SYS.mshdb 

(Note: The WB_Remesh.wbjn is the user-defined 

remeshing script developed by ANSYS and is in the 

example files provided) 
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xiii. Finalising the CFX-Pre Setup 

i. Check if there are any error messages in the message box and amend them before 

proceeding further. 

ii. Write the solver definition file 

 Right click on Simulation Control and select ‘Write Solver Input File’ 

iii. Simulation is ready to be initialised using the solver definition file, 

SUBOFFExplorer.def. 

 

AII.6.4 Prescribed Motion Results 

 

The simulation was performed with:  

 the SUBOFF and Explorer undergoing a forward speed of 1.2m/s; 

 the SUBOFF undergoing a oscillatory motion in the transverse (y) direction with amplitude of 

0.14m and a frequency of 0.2Hz; and 

 the SUBOFF nosetip at an initial position of 0.75m laterally and 0m longitudinally relative to 

the Explorer nosetip.  

 

Figures AII.16 and AII.17 show the simulation predictions of the longitudinal force and lateral force 

acting on the SUBOFF, respectively. The simulations were carried out using the BSLRSM turbulence 

model and a time step of 0.01s.  
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Figure AII.16:  Simulation results of the SUBOFF transverse position and longitudinal force (Fx)  

 

Figure AII.17: Simulation results of the SUBOFF transverse position and transverse force (Fy)  

 

AII.7 Motion Response Test Case 

 

AII.7.1 Geometry 

 

The vehicle is represented by the SUBOFF model. The dimension of the fluid domain is 20m long, 

3.55m wide and 1.5m high in order replicate the dimensions of the AMC Towing Tank.  

 

 

Figure AII.18: Motion response test case fluid domain  

 

AII.7.2 Test Case Condition 
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A prescribed motion simulation was first carried out to determine the longitudinal force acting on the 

SUBOFF while it travels forwards 1.2m/s. The obtained longitudinal force, -1.5N, was prescribed as 

an external force in the opposite direction, representing thrust, on the SUBOFF in a coupled CFD-

RBD simulation in order to examine the capability of the CFD-RBD simulation in reproducing the 

motion of the SUBOFF moving forward at 1.2m/s. The mesh model is the same for both the 

prescribed motion simulation and motion response simulation. 

 

For the test case, the SUBOFF nosetip is initially located 10m fore of Outlet fluid domain boundary 

and at a depth of 0.75m. A summary of the test conditions and the rigid body parameters of the 

SUBOFF are given in Table AII.2. 

 

Table AII.2: Motion response test case parameters 

Parameter SUBOFF 

Initial nosetip coordinate [x, y, z] 5m,0m,-0.75m 

Mass 318.6kg 

Mass moment of inertia [ Ixx, Iyy, Izz, Ixy, Ixz, Iyz] 31.86kgm
2 

Prescribed external force 1.5N in x-direction 

Degrees of Freedom 1; x-axis translation 

Initial linear velocity 1.2m/s in x-direction 

 

AII.7.3 Test Case Simulation: CFX-Pre Setup 

 

Note: Red font = expression 

 

General 

i. Create the mesh models of the fluid domain and the vehicle subdomain at its initial 

locations following the instructions in Section 3. 

ii. Open CFX-Pre. 

iii. Go to Edit>Options> CFX-Pre>General> Auto Generation and disable Automatic 

Default Interfaces 

iv. Create a new General Case and save as “SUBOFF.cfx” in working directory 

v. Import the subdomain meshs - Right click on Mesh tree > Import Mesh > ANSYS 

Meshing. Change file filter to all files to find the *.meshdat files 

vi. Import the outer domain mesh  from workbench project archive, e.g. [working 

directory]/SUBOFF_files/dp0/MECH/SYS.mshdb 
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vii. Simulation>Flow Analysis 1> Analysis Type>  

 Option> Transient 

 Time Duration> Option> Total Time 

 Total Time > CSimTime  

 Time Steps> 

 Option > Timesteps 

 Timesteps > CSimTimeStep 

 Initial Time> 

 Option > Automatic with Value 

 Time > 0 [s] 

 

Rigid Body 

i. Right click on Flow Analysis 1 and insert Rigid Body 1 for the SUBOFF 

ii. Rigid Body: Rigid Body 1 > 

 Basic Settings > 

 Mass > 318.6 [kg] 

 Location > SUBOFF 

 Mass moment of inertia > 31.86 [kgm^2]
 
for all 

 Dynamics > 

 External Force 1 > 

 Option > Value 

 Force > 

 Option > Cartesian Components 

 X Component > 1.5 [N] 

 Y Component > 0 [N] 

 Z Component > 0 [N] 

 Degrees of Freedom > 

 Translational Degrees of Freedom > 

 Option > X axis 

 Initial Conditions > 

 Linear Velocity > 

 Option > Automatic with Value 
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 X Component > 1.2 [ms^-1] 

 Y Component > 0 [ms^-1] 

 Z Component > 0 [ms^-1] 

 

Fluid Domain 

i. Rename ‘ Default Domain’ to ‘FluidDomain’ 

ii. FluidDomain > Basic Settings > 

 Location and Type > 

 Location > ….. (Select all three mesh) 

 Domain Type > Fluid Domain 

 Fluid 1 > Option > Material > Water 

 Domain Models > Pressure > Reference Pressure > 1 [atm] 

 Buoyancy Model > Non-Buoyant 

 Domain Motion > Stationary 

 Mesh Deformation> 

 Option > Regions of Motion Specified 

 Mesh Motion Model > Option > Displacement diffusion 

 Mesh stiffness > 

 Option > Increase near Boundaries 

 Model Exponent > 10 

 

Vehicle Subdomain 

i. Right click on FluidDomain and insert Subdomain 1 for the SUBOFF subdomain 

ii. Subdomain: Subdomain 1 > 

 Basic Settings > Location > [Select SUBOFF subdomain] 

 Mesh Motion > Mesh Motion > 

 Option > Rigid Body Solution 

 Rigid Body > Rigid Body 1 

 

Subdomain Interface 

i. Right click on FluidDomain and insert Domain Interface 1 for SUBOFF subdomain.  

ii. Domain Interface 1> 

 Basic Settings > 
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 Interface Type > Fluid Fluid 

 Interface Side 1 

 Domain (Filter) > FluidDomain 

 Region List > SUBOFFInnerInterface 

 Interface Side 2 

 Domain (Filter) > FluidDomain 

 Region List > SUBOFFOuterInterface 

 Additional Interface Models > 

 Mass and Momentum > Conservative Interface Flux 

 Mesh Connection Method > 

 Mesh Connection > GGI 

iii. Fluid Domain> 

 Domain Interface: Domain Interface 1 Side 1 > Boundary Details > 

 Mesh Motion > 

 Option > Rigid Body Solution 

 Rigid Body > Rigid Body 1 

 Domain Interface: Domain Interface 1 Side 2 > Boundary Details > 

 Mesh Motion > 

 Option > Rigid Body Solution 

 Rigid Body > Rigid Body 1 

 

Domain Boundaries 

Inlet: 

i. Right click on Fluid Domain and insert boundary ‘Inlet’ 

ii. Fluid Domain > Boundary: Inlet >  

 Basic Settings > 

 Boundary Type > Opening 

 Location > Inlet 

 Boundary Details >  

 Mass and Momentum > 

 Option > Opening Pres. And Dirn 

 Relative Pressure > 0 [Pa] 
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Outlet: 

i. Right click on Fluid Domain and insert boundary ‘Outlet’ 

ii. Fluid Domain > Boundary: Outlet >  

 Basic Settings > 

 Boundary Type > Opening 

 Location > Outlet 

 Boundary Details >  

 Mass and Momentum > 

 Option > Opening Pres. And Dirn 

 Relative Pressure > 0 [Pa] 

 

Wall: 

i. Right click on Fluid Domain and insert boundary ‘Wall’ 

ii. Fluid Domain > Boundary: Wall >  

 Basic Settings > 

 Boundary Type > Wall 

 Location > Wall 

 Boundary Details >  

 Mass and Momentum > 

 Option > Free Slip Wall 

 

SUBOFF: 

i. Right click on Fluid Domain and insert boundary ‘SUBOFF’ 

ii. Fluid Domain > Boundary: SUBOFF >  

 Basic Settings > 

 Boundary Type > Wall 

 Location > SUBOFF 

 Boundary Details >  

 Mesh Motion > 

 Option > Rigid Body Solution 

 Rigid Body > Rigid Body 1 

 Mass and Momentum > 
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 Option > No Slip Wall 

 

Domain Initialization 

i. FluidDomain > Initialization 

 Domain Initialization > Initial Conditions > 

 Cartesian Velocity Components > 

 Option > Automatic with Value 

 U > 0 [m s^-1] 

 V > 0 [m s^-1] 

 W > 0 [m s^-1] 

 Static Pressure > 

 Option > Automatic with Value 

 Relative Pressure > 0 [Pa] 

 

Solver 

i. Solver Control > Basic Settings >  

 Advection Scheme > High Resolution 

 Transient Scheme >  

 Option > Second Order Backward Euler 

 Timestep Initialization > Automatic 

 Turbulence Numerics > Option > First Order 

 Convergence Control > 

 Min. Coeff. Loops > 1 

 Max. Coeff. Loops > 3  

 Interrupt Control > Interrupt Control Conditions > 

 Insert ‘Interrupt Condition 1’ 

 Interrupt Condition 1 > 

 Option > Logical Expression 

 Logical Expression > MeshOrthoAngle < 10 

ii. Right click on Solver and insert ‘Expert Parameters’ 

 Expert Parameters > Discretisation > meshdisp diffusion scheme > value > 3 

 Expert Parameters > Convergence Control > Memory Control > 
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 Enable ‘topology estimate factor’ 

 Value = 1.2 

iii. Output Control >  

 Trn Results > Transient Results > 

 Insert ‘Transient Results 1’ 

 Transient Results 1 >  

 Output Frequency >  

 Option > None 

 Monitor > Monitor Points and Expressions >  

 Insert the monitor points below. Note that it is essential that the names 

of the monitor points tracking the position and orientation of the 

SUBOFF be identical to the names of their respective parameters in 

WorkBench for the remeshing process. 

 Monitor Point Name > SUBOFF_RollAngle 

 Expression Value >  

(rbstate(Euler Angle X)@SUBOFF)*180/pi 

 Monitor Point Name > SUBOFF_PitchAngle 

 Expression Value >  

(rbstate(Euler Angle Y)@SUBOFF)*180/pi 

 Monitor Point Name > SUBOFF_YawAngle 

 Expression Value >  

(rbstate(Euler Angle Z)@SUBOFF)*180/pi 

 Monitor Point Name > SUBOFF_LocX 

 Expression Value >  

ave(Total Centroid Displacement X)@SUBOFF 

 Monitor Point Name > SUBOFF_LocY 

 Expression Value >  

ave(Total Centroid Displacement Y)@SUBOFF 

 Monitor Point Name > SUBOFF_LocZ 

 Expression Value >  

ave(Total Centroid Displacement Z)@SUBOFF 

 Monitor Point Name > SUBOFF_VelP 

 Expression Value >  
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rbstate(Angular Velocity X)@SUBOFF 

 Monitor Point Name > SUBOFF_VelQ 

 Expression Value >  

rbstate(Angular Velocity Y)@SUBOFF 

 Monitor Point Name > SUBOFF_VelR 

 Expression Value >  

rbstate(Angular Velocity Z)@SUBOFF 

 Monitor Point Name > SUBOFF_VelU 

 Expression Value >  

rbstate(Linear Velocity X)@SUBOFF 

 Monitor Point Name > SUBOFF_VelV 

 Expression Value >  

rbstate(Linear Velocity Y)@SUBOFF 

 Monitor Point Name > SUBOFF_VelW 

 Expression Value >  

rbstate(Linear Velocity Z)@SUBOFF 

 Monitor Point Name > SUBOFF_AccelPdot 

 Expression Value >  

rbstate(Angular Acceleration X)@SUBOFF 

 Monitor Point Name > SUBOFF_AccelQdot 

 Expression Value >  

rbstate(Angular Acceleration Y)@SUBOFF 

 Monitor Point Name > SUBOFF_AccelRdot 

 Expression Value >  

rbstate(Angular Acceleration Z)@SUBOFF 

 Monitor Point Name > SUBOFF_AccelUdot 

 Expression Value >  

rbstate(Linear Acceleration X)@SUBOFF 

 Monitor Point Name > SUBOFF_AccelVdot 

 Expression Value >  

rbstate(Linear Acceleration Y)@SUBOFF 

 Monitor Point Name > SUBOFF_AccelWdot 

 Expression Value >  
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rbstate(Linear Acceleration Z)@SUBOFF 

 Monitor Point Name > SUBOFF_Fx 

 Expression Value >  

force_x()@SUBOFF 

 Monitor Point Name > SUBOFF_Fy 

 Expression Value >  

force_y()@SUBOFF 

 Monitor Point Name > SUBOFF_Fz 

 Expression Value >  

force_z()@SUBOFF 

 Monitor Point Name > MeshAngleQuality 

 Expression Value >  

MeshOrthoAngle 

 

Expressions 

i. Insert the following expressions: 

 Expression Name > CSimTime 

 Definition > 10 [s] 

 Expression Name > CSimTimeSteps 

 Definition > 0.01 [s] 

 Expression Name > MeshOrthoAngle 

 Definition >  

180/pi*minVal(Orthogonality Angle Minimum)@REGION:B40 

 

Execution Control 

i. Right on Simulation Control and insert ‘Execution Control’ 

 Execution Control >  

 Run Definition >  

 Solver Input File > [working directory]/SUBOFF.def 

 Parallel Environment 

 Run Mode > Platform MPI Local Parallel 

 Number of Processes > 7 

 Partitioner > 
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 Partitioning Detail > 

 Partitioner Type > Optimised R.C.B. 

 Partitioning Weighting > Automatic 

 Partitioner Memory > 

 Memory Alloc Factor > 1.4 

 Solver > 

 Solver Memory > 

 Memory Alloc Factor > 1.4 

 

Remeshing Configuration 

i. Right click on Configuration and insert ‘Configuration 1’ 

 Configuration 1 >  

 General Settings > 

 Insert ‘Activation Condition 1’ 

 Activation Condition 1 > 

 Option > Start of Simulation 

 Remeshing > 

 Under Remesh Definitions, insert ‘Remesh 1’ 

 Remesh 1 > 

 Option > User Defined 

 Activation Condition(s) > Interrupt Condition 1 

 Location > B40 

(Note: Specify the FluidDomain reference ID) 

 External Command >  

/ansys_inc/v140/Framework/bin/Linux64/runwb2 -B –R /[working directory]/WB_Remesh.wbjn 

 Replacement File > 

/[working directory]/SUBOFF_files/dp0/MECH/SYS.mshdb 

 

Finalising the CFX-Pre Setup 

i. Write the solver definition file as SUBOFF.def. 

 

AII.7.4 Simulation Results 
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Figure AII.19 show the predicted position and velocity of the SUBOFF in response to the prescribed 

thrust force of 1.5N with respect to time.  The averaged predicted linear velocity of the SUBOFF in 

the x-direction was 1.2m/s with a standard deviation of 0.01% (99% confidence level), matching the 

desired velocity response, 1.2m/s.  The distance travelled after 10s was 12.01m which was 

within 0.08% of the analytical solution, 12.00m. 

 

 

Figure AII.19:  Simulation results of the SUBOFF position and velocity as a function of time for the 

motion response test case.  
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Appendix III :  

The ANSYS CFX-MATLAB Interface 

 

AIII.1 Introduction 

 

This appendix presents an interface to couple the CFD model within ANSYS CFX to a 

control system within a MATLAB environment for manoeuvring simulations. The CFD 

model also includes a built-in Rigid Body Dynamics model that enables it to predict the 

motion response of the AUV to its control planes, propulsion, and external forces. The 

interface presented relies on the native languages of the ANSYS CFX module, the MATLAB 

module and the operating system, thus avoiding compatibility issue and the need for user 

defined subroutines within ANSYS CFX.  

 

The capability of the interface is demonstrated through a simulation of an AUV moving in 

parallel to relative to a larger vehicle, with the AUV’s propulsion controlled through the 

MATLAB environment. The results shown within this appendix have been produced to 

demonstrate capability. The results presented here must not be taken as accurate predictions.  

 

AIII.2 Simulation Architecture 

 

 
Figure AIII.1: Block diagram of the simulation subcomponents. 

 

Figure AIII.1 shows the block diagram of the simulation architecture. The simulation is 

controlled via a user interface within the MATLAB environment. The simulation is 

controlled via the MATLAB environment whereby the test parameters and the vehicle control 

states can be changed either through the user interface or vehicle control system module. The 

hydrodynamic forces and moments of the vehicles, i.e. X, Y, Z, K, M, N, are computed using 

the CFD solver within ANSYS CFX. The motion of the vehicles, i.e. translation and rotation, 
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in response to the hydrodynamic components, gravitational forces, inertia forces, and 

additional external forces such as propulsion, are then computed by the 6-DOF RBD solver 

within ANSYS CFX. The ANSYS CFX output containing the external forces and moments, 

positions, Euler angles, velocities, and accelerations of the vehicles are transferred to the 

MATLAB-based control system through the ANSYS CFX-MATLAB Interface (ACMI). 

Based on the information from ANSYS-CFX, the control system computes the new states of 

the control components of the vehicles (e.g. control fins, propulsion or their equivalent forces 

and moment) in order to maintain the desired trajectory. The new states of the control 

components of the vehicles are transferred back into ANSYS CFX through the AMCI, and 

the control components of the vehicles within ANSYS CFX are updated accordingly. Figure 

AIII.2 shows the flow process of the ACMI. 

 

 

Figure AIII.2:  Flow process of the ANSYS CFX-Matlab Interface simulation. 

 

Note: The simulation generates a comma-separated-value format dat file containing the 

variables monitored by CFX which can be plotted in MATLAB. The dat file is updated when 

the simulation is interrupted every 0.2s. 
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AIII.3 Test Case (Implementaion of the ACMI) 

 

The test case involves the DARPA sized SUBOFF overtaking a cylindrical-shaped body 

(Vehicle 2) which eight times larger than the former (see Figure AIII.3). The SUBOFF is 

propelled forward by a thrust force of 104N and has an initial speed of 0.8m/s in the x-

direction at the start of the simulation. After 8s, the thrust force is reduced to 52N by the 

dummy control code in the MATLAB script. The purpose of the test case is to verify the 

capability of the interface to initiate and control the simulation using a MATLAB script. A 

summary of the test case conditions are summarized in Table AIII.1. 

 

 

Figure AIII.3:  Fluid domain and mesh model of the ACMI test case  

 

Table AIII.1: ACMI test case parameters 

Parameter SUBOFF Vehicle 2 

Initial nosetip coordinate [x, y, z] 0m, 0m, 30m 30m, 3m, 30m 

Length 4.356m 34m 

Diameter 0.508m 4m 

Mass 699.21kg - 

Mass moment of inertia [ Ixx, Iyy, Izz, Ixy, Ixz, Iyz] 69.92kgm
2 

- 

Motion  Solution Dependent (RBD) Stationary 

Prescribed thrust force 104N 

52N (after 8s) 

- 

Inlet flow speed 1m/s 
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AIII.3.1  Test Case Setup 

 

The setup approach for the ANSYS CFX component of the simulation is similar to the 

motion response test case outlined in Appendix 2.  

 

The simulation model files listed in Table AIII.2 are provided in the storage media attached 

to this thesis and online at  

<https://www.dropbox.com/s/d82o3gm8oca5c8m/Remesh18SuboffLinuxV1_170912.zip>.  

 

A description of the terminal-based ANSYS CFX commands and MATLAB commands for 

the interface between the two environments is given in the M-files (*.m). 

 

Table AIII.2: List of simulation files for the CFX-MATLAB interface test case 

File Description 

Suboff.wbpj Workbench project file. 

Suboff_files Workbench project subfolder containing the geometry 

and mesh files. 

ControlVariables.ccl Variables that can be controlled by the MATLAB 

environment.   

Edit parameters before initialising the simulation to set 

the initial conditions. The same file used by MATLAB 

to update the simulation variable when it is running. 

InitiateSimLoop.m MATLAB script used to initiate and control the CFX 

simulation. 

ControlDummy.m MATLAB script allowing results to be extracted 

system during simulation into a readable format (csv) 

by a MATLAB-based control system.  

Updates the simulation variables with the control 

outputs. 

WB_Remesh.wbjn The CFX re-meshing script. Generic, requires no 

modification. 

 

AIII.3.2 Running the Simulation 

i. Extract the simulation files to “/tmp/Remesh/”. If another working directory is 

preferred, change the paths accordingly in the ‘ControlVariables.ccl’ file. 

ii. Run the InitiateSimLoop.m to initiate the simulation. 

 

 

 

https://www.dropbox.com/s/d82o3gm8oca5c8m/Remesh18SuboffLinuxV1_170912.zip
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AIII.3.3 ACMI Test Case Results 

Figure AIII.4 shows the time history of the SUBOFF velocity in response to the thrust force 

prescribed by the MATLAB script. Slight fluctuations were observed at the start of the 

simulation which is normal due to the simulation calculating a reasonable equilibrium state in 

the first two to three time steps. The velocity of the SUBOFF increases up to the point of 8s 

where the prescribed thrust force is reduced to half. The velocity decreases thereafter as 

expected, thus verifying the capability of the MATLAB script to control the CFX simulation.     

 

 

Figure AIII.4:  Time history of the SUBOFF velocity in the x-direction in response to the prescribed 

thrust force by the MATLAB script. 
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